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The Content of this Guide 
The purpose of this guide is to provide workers with a basic tool to navigate through the 
CONNECTIONS system. It will guide the user with step-by-step instructions to complete basic 
tasks that are common for all workers. The information presented here is a simplified, 
condensed version of the content provided in the more comprehensive CONNECTIONS Case 
Management Step-by-Step Guide.  

Features of this Guide  
• Tips, set apart in margin boxes, provide information to help you carry out 

CONNECTIONS tasks efficiently and effectively. Icons in the boxes help identify three 
kinds of tips: 

Helpful hints 

Things to watch out for 

 Where am I?  

Step-by-Step Instructions: The beginning of this guide includes instructions for logging 
onto the computer and accessing CONNECTIONS. Subsequent Step-by-Step 
instructions assume you have logged onto your computer and accessed 
CONNECTIONS. Step-by-Step instructions for each task are divided into major sub-
steps so that you may move ahead or review steps at your own pace. 
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CONNECTIONS Basics 

What is the CONNECTIONS System? 
CONNECTIONS is a child welfare computer system that provides for the documentation of 
information about families and children in New York State. The CONNECTIONS system is part 
of a federal initiative called the Statewide Automated Child Welfare Information System 
(SACWIS). In 1993, the federal government provided financial incentives for states to develop 
statewide automated child welfare processes in an effort to provide more efficient and effective 
administration of programs. In addition, the federal government introduced a set of foster care 
and adoption-related data elements to be collected by states’ SACWIS systems—the Adoption 
and Foster Care and Analysis and Reporting System (AFCARS)—so that national data would 
be available in a consistent format. Many other states have similar systems with other names. 

CONNECTIONS is designed to create a single, statewide, integrated system for the collection 
and recording of child protective, preventive, foster care and adoption service information. The 
CONNECTIONS system will eventually replace the existing New York State “legacy” systems—
the Welfare Management System (WMS) used in child welfare cases, the Child Care Review 
Service (CCRS) and the Adoption Album. It will interface with the Benefits Issuance Control 
System (BICS), Child Support Management System (CSMS), and WMS Non-Services, including 
Medicaid (MA). 

• CCRS - CONNECTIONS will replace CCRS as the 
repository of all information on child assessments and 
service plans, legal activity, placements and moves 
within placement. CCRS will be available in view-only 
mode only. [Note: This process will be completed with 
a future build.} 

• WMS - CONNECTIONS will replace WMS Services 
as the system of record for authorizing all child 
welfare services (i.e., protective, preventive, foster 
care and adoption). [Note: This process will be 
completed with a future build.] 

• BICS - BICS will continue to be the system of record 
for all payments made on behalf of families and 
children receiving child welfare services. 
CONNECTIONS will interface with BICS. 

• Interstate Compact for the Placement of Children 
(ICPC) - The ICPC database will be replaced by 
CONNECTIONS and all ICPC requests and 
subsequent processing will be completed through CONNECTIONS. 

 
Until the interface process is 

complete, the paper 
application for services (2921) 
is the same and still must be 
signed. WMS will continue to 

be the system of record to 
authorize and pay for child 

welfare services, and it is still 
necessary to close WMS 

cases in the WMS system. 
CCRS will remain the system 

of record for child 
assessments and service 

plans, legal activity, 
placements and moves within 

placement. 

• Adoption - All system recording in regard to adoption, including photo-listing and 
adoption subsidy, will be completed in CONNECTIONS. [Note: CONNECTIONS will 
not replace the Adoption Album legacy system until Build 19 is fully implemented.] 

CONNECTIONS is updated through Builds. When fully implemented across the state, the 
system will provide full case and financial management support for child welfare related staff, 
appropriate access to client information for those needing the information, decision-making 
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support tools for caseworkers and managers, and support payment and claiming processes. 
Through the statewide network, CONNECTIONS will link child welfare caseworkers, 
supervisors, and other management and administrative staff. 

Logging On to Your Computer 
The CONNECTIONS application can be accessed only by designated individuals on computers 
that are set up to run the application. CONNECTIONS computers use the Windows 2000 
Operating System. 

 

Step-by-Step: 
Logging On to Your Computer 

1 Press the Ctrl + Alt + Delete keys on your keyboard at the same time. 
A Confidentiality warning displays. 

2 Click on the OK button in response to the Confidentiality warning. 
The Log On window displays. Make sure that your user name and domain are listed 
correctly in the log on dialog box.  

3 Enter your password and click on the OK button. 
Your local desktop displays. 

Launching CONNECTIONS 
CONNECTIONS resides on a centralized Citrix server. The 
Connections and other Citrix Applications icon on your local 
desktop opens the Connections and other Citrix Applications 
window, which contains icons of applications that are available 
to you based on your NT logon. When you select one of the 
CONNECTIONS log in icons from the Connections and other 
Citrix applications window, your computer accesses the Citrix 
server and begins a “Citrix session.” The Citrix desktop 
displays, covering your local desktop and remaining open for 
the length of your Citrix session. Workers using 95% screen 
resolution will notice that they will still see a portion of their local 
desktop. The Citrix desktop also has an easily recognizable background. 

 

Depending on the setting of 
your screen resolution, you can 

use the CONNECTIONS 
desktop full screen icon on the 

CONNECTIONS and Other 
Citrix Applications window. 

 

Step-by-Step: 
Launching CONNECTIONS (Production) 

1 From your local desktop, double-click the Connections and other Citrix 
Applications icon. 
The Connections and other Citrix Applications window displays, containing icons of 
applications that are available to you based on your NT logon. 

2 Double-click the Connections Desktop 95 Percent icon.  
A Confidentiality Warning message displays. 
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3 Click on the OK button in response to the Confidentiality Warning. 
The Citrix desktop displays and your Citrix session begins. 

4 Double-click the Connections icon. 
When the CONNECTIONS Production Database has launched successfully, the 
CONNECTIONS Toolbar displays, reading: Production – CONNECTIONS Toolbar – 
<Your Name>. 

Closing CONNECTIONS and Logging  Your PC 
When you have finished your work in CONNECTIONS, you should close both CONNECTIONS 
and your Citrix session. This is best done as a two-step process: first close CONNECTIONS, 
then log off of Citrix. Doing so (as opposed to logging off of Citrix while CONNECTIONS is still 
open) reduces the likelihood of problems occurring during the log off procedure. It is also 
important to log off your computer at the end of your work day. Leaving your computer logged 
off (but with the power still on) provides for the automated system updates that may occur 
overnight.  

 

Step-by-Step: 
Closing CONNECTIONS and Logging Off Your PC 

1 Click on the File menu (represented by the Globe icon [ ] in the upper left corner of 
the CONNECTIONS Toolbar) and select the Close command. 

2 Click on the Start button in the lower left corner of the Citrix desktop and select Log 
Off <User name> from the resulting menu. 
The following message displays: 
”Are you sure you want to log off?” 

3 Click on the Yes button. 
This does not log off your machine; it only ends your session with the Citrix 
server. Your local desktop displays. 

4 Close all applications still open on your local desktop. 
5 Click on the Start button. 

The Start menu displays. 
6 Select the Shut Down command. 

The Shut Down Windows dialog box displays. Click on the drop-down arrow and 
select Log off <user name>, if it is not already selected. 

7 Click on the OK button. 
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Support Tools 

OCFS CONNECTIONS Intranet Site 
A variety of training-related materials are available on the OCFS CONNECTIONS intranet site 
(http://ocfs.state.nyenet/connect/). 

The intranet site contains a wealth of information related to various aspects of CONNECTIONS, 
including training schedules, Alerts and Notices, and Frequently Asked Questions (FAQs). 

 

Step-by-Step: 
Accessing the OCFS Intranet Site 

1 Double-click on the Internet Explorer icon. 
The OCFS intranet home page displays.  

2 Click on the CONNECTIONS link. 
The CONNECTIONS home page displays. 

 
If the OCFS intranet home 

page does not display 
automatically, enter 

http://ocfs.state.nyenet/connect/ 
in the address bar and click on 

the Go button (or press the 
Enter key on your keyboard); 

skip Step 2... 

3 Click on the Step-by-Step/Job Aids/Tips link on the 
CONNECTIONS home page.  
The Step-by-Step Guides page displays. 

4 Click on the desired link (e.g., Step-by-Step 
Guides, Job Aids).  

5 Click on the name of the desired document. 
The document displays in PDF format. 

6 Minimize the guide by clicking on the minimize ( ) 
button. 

 

Online Help 
Online Help provides you with comprehensive information while using the CONNECTIONS 
application, including definitions, descriptions for various windows, step-by-step instructions for 
common tasks and more. You can access Online Help at any time, from any window in 
CONNECTIONS by clicking on the Help menu or pressing the F1 key on your keyboard. The 
display of Help depends on from where in the system it is accessed (e.g. the Family Services 
Stage window or the Task List). 
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The Online Help system includes a table of contents that displays all Help topics, allowing easy 
navigation through the Online Help system. 

 

Step-by-Step: 
Using Online Help 

 

 

1 Click on the Help menu on the CONNECTIONS Toolbar. 
Choose from the following commands: 

• Contents 
A table of contents for the help facility with links to major sections. 

• How Do I? 
Step-by-instructions to help you complete tasks using CONNECTIONS. 

• Window Descriptions 
Descriptions of windows in CONNECTIONS, along with information on 
various fields. 

• DSS Policy 
Online OCFS policy handbooks (not currently available). 

• Help On This Window 
Window description help for the window you are on. 

• Help for Help 
Instructions on how to use the help functionality. 

• About CONNECTIONS 
Information about the current CONNECTIONS version and build. 

2 Click on a command from the Help menu. 
The window related to your selection displays. In some cases, you will need to make 
another selection in that window to obtain instructions. At the top of each window, 
you’ll see additional buttons and menus. The Search tab enables you to search for 
specific information in the Help function; the Back button returns you to windows 
you’ve just visited in Help; the Glossary button opens a list of important 
CONNECTIONS terms; and the Print button allows you to print Help information. 

3 When you’re done reviewing information in Help, close each Help window by clicking 
on the File menu and selecting the Exit command.  
The CONNECTIONS Toolbar displays. 
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A separate Online Help file was created to support the Child Protective Record Summary 
(CPRS), Family Services Intakes and Family Services Stages. The CPRS is a single window in 
CONNECTIONS that provides demographic information and investigative findings in one place. 

This separate Help file provides context-sensitive Help information for all elements of the CPRS, 
FSI and FSS, including tabs, grids, buttons and individual fields. It also offers many navigational 
tools that guide you to the Help topic you need: 

• A Table of Contents provides access to all Help information. 
• Index and Search functions provide alternate means of finding information. 
• Interactive graphic examples of various elements contain hyperlinks that display related 

information, such as definitions and procedural guidelines. 
• Overview provides a high-level summary of the CPRS, FSI or FSS, including a list of 

features and functions. 
• “How Do I?” provides information for navigating within the CPRS, FSI and FSS including 

how to use the functions. 
• The Glossary contains definitions of commonly used terms in Child Welfare Services and 

definitions of various elements and concepts. 
• Help on Help provides instructions for using the Online Help system. 

The Enterprise Help Desk 
The New York State Office for Technology (NYS OFT) Enterprise Help Desk staff are available 
to answer basic questions related to your equipment, or to solve problems you’re having with 
the CONNECTIONS application. If they cannot solve your problem, they will record your 
information and forward it to others who can. 

Your agency may have procedures in place for contacting the Enterprise Help Desk. Check with 
your supervisor before you call. 

The Help Desk is staffed 24 hours a day, seven days a week. The telephone number is: 

1-800-NYS-1323  
(1-800-697-1323) 

When you call the Enterprise Help Desk with a problem, you will be given a ticket number to use 
for tracking your issue and its resolution. Keep a record of this number; you will need it for any 
follow-up conversations with the Enterprise Help Desk. 
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Switching Between CONNECTIONS and Applications on Your Local 
Desktop 
The Alt+Tab hot key combination enables you to move between your Citrix session and other 
applications on your local desktop. If your desktop screen resolution within your settings is set at 
100% 800 by 600 resolution you will need to use the hot key functionality. 

 

Step-by-Step: 
Using Alt+Tab to Switch Between Applications 

1 Hold down the Alt key. 
2 Briefly press and release the Tab key to cycle through open application windows. 

With each press of the key, a pop-up window displays with the name/icon of an open 
application window. 

3 When you see the name of the application you want to access, release the Alt key. 
The open application window you selected becomes the active window. 

The Ctrl+Esc hot key combination also enables you to move between your Citrix session and 
other applications on your local desktop. The Start menu for your local desktop displays when 
you use Ctrl+Esc on your keyboard. 

If your computer has 95% Screen Resolution, you do not need to use Alt+Tab; instead, use the 
Task Bar on your local desktop at the bottom of the screen to navigate among applications. The 
Start button is located to the left of the Task Bar. Any applications that are open will appear on 
the Task Bar at the bottom of the screen.  

 

Switching Between Open Windows While in a Citrix Session 
To switch between open windows on the Citrix desktop, click on the desired application’s task 
button on the Citrix Task Bar. 

Even though parts of a window may be visible, that window might not be the active window. 
Clicking anywhere within a window will make it the active window, placing it on top of any other 
open windows. Sometimes the active window (such as the Print dialog box) must be closed 
before you can select another window. 
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Copying and Pasting 
In CONNECTIONS, as in other Windows-based applications, you can use the Copy and Paste 
functions to duplicate narrative entries without retyping text. 

 

Step-by-Step: 
Copying and Pasting Text 

1 Open the window (e.g., a Microsoft Word document) that contains the text to be 
copied. 

2 Click and hold the mouse button down while you drag the cursor over the text you 
want to copy. 
The text highlights in black as you drag the mouse. 

3 Click on the Edit menu and select Copy. 
The system copies the highlighted text onto a temporary Windows “clipboard.” It will 
remain on this clipboard until you copy another selection of text or close the 
application. (If an Edit menu is unavailable on a particular CONNECTIONS window, 
use the hot key method described at the end of this section.) 

4 If you need to switch to another window, either click on that window to make it active, 
or click on the appropriate button on the Task Bar at the bottom of the Citrix desktop. 
If you are moving from a stand-alone Word document to an open Word document in 
CONNECTIONS, use Alt+Tab to move from one document to the other, or minimize 
the first document by clicking on the Minimize button ( ) in the top right corner of 
the window. 

5 Click on the location where you want to paste the text. 
6 Click on the Edit menu and select Paste. 

The copied text is pasted next to the cursor. If an Edit menu is unavailable on a 
window, use the hot key method described on the next page. 

Hot Key Method for Copying and Pasting  
If an Edit menu is unavailable on a window where you want to copy and/or paste, you can use 
the following “hot key” method to copy and paste. 

 

Step-by-Step: 
Copying and Pasting Text via the Hot Key Method 

1 Highlight the text you want to copy. 
2 Press the Ctrl and C keys on your keyboard at the same time. 

The highlighted text is copied onto the Windows “clipboard.” 
3 Click on the location where you want to paste the text. 
4 Press the Ctrl and V keys on your keyboard at the same time. 

The copied text is pasted next to your cursor. 
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The CONNECTIONS Toolbar 

 

Using CONNECTIONS Toolbar Buttons 
The CONNECTIONS Toolbar is always available at the top of your screen when you are 
working in CONNECTIONS. It is the gateway into the CONNECTIONS system. Sometimes the 
Toolbar may display beneath another window on your desktop. Click on the title bar to bring the 
Toolbar to the forefront of all of your open windows. 

The first two buttons on the CONNECTIONS Toolbar (TO-DO and WORK) help you organize 
your day-to-day work. The TO-DO button opens the Staff To-Do List, containing items needing 
your attention. The WORK button opens the Assigned Workload, a list of your stage 
assignments. This is the method you use to access your tasks in CONNECTIONS. 

The third button, UNIT, opens the Unit Summary window, which is available only to 
CONNECTIONS users who have been assigned the UNIT SUM ACCESS Business Function 
(This Business Function is typically assigned to supervisors, but others could be assigned this 
Business Function as well). For anyone with the UNIT SUM ACCESS Business Function, the 
Unit Summary window provides access to the workloads of the workers they supervise. For 
workers who have not been assigned the UNIT SUM ACCESS Business Function, this button is 
disabled. 

The next four buttons (PERS, CASE, RSRC and STAFF) are search buttons, which enable you 
to search for people, cases, resources (including foster homes, agencies and service providers) 
and staff in CONNECTIONS. 

The final button, RPRTS, opens the Report List, which provides access to reports that you’ve 
generated (or “launched”) from within the application. Monthly management reports are also 
downloaded directly into the RPRTS window for people with a special Business Function Profile. 
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CONNECTIONS Security 
Workers must understand their role and responsibilities regarding the security of 
CONNECTIONS information. They have an obligation to protect and preserve all information in 
a consistent and reliable manner. Designated staff are responsible for ensuring that appropriate 
physical, logical and procedural controls are in place to preserve the confidentiality, integrity, 
availability and privacy of CONNECTIONS information. 

 

 
For important information about CONNECTIONS security,  

see Appendix A: OCFS Security Guidelines. 

 

 

 

 

In order to protect the confidentiality and integrity of case data, access to information in 
CONNECTIONS is carefully controlled. There are a number of factors that determine what 
information you can view or maintain in CONNECTIONS. These include job function, assigned 
cases and Business Function Profile (BFP).  

All CONNECTIONS users receive security profiles which determine the windows they can open 
and view, as well as which information they can modify or “maintain” (e.g., the correct Business 
Function, “Create FSI,” is needed to begin a Non-CPS Intake.). In CONNECTIONS, each 
person’s security profile is called a Business Function Profile (BFP). Your BFP is based on the 
tasks you are responsible for performing and the level of access to records needed to complete 
those tasks.  
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Managing Your Workload 

CONNECTIONS provides tools designed for caseload management. These tools include the 
Assigned Workload and the To-Do Lists. 

The Assigned Workload 
The Assigned Workload is an important workload management tool in CONNECTIONS. It lists 
all of the stages assigned to a worker, along with basic information about those stages. 

New assignments do not automatically display on the Assigned Workload if the Assigned 
Workload is open at the time the assignment is made in the system. It is necessary to refresh 
the workload for these assignments to display. To refresh the Assigned Workload, click on the 
Refresh button. 
 

 

Step-by-Step: 
Opening the Assigned Workload 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

The following columns on the Assigned Workload provide an abbreviated view of relevant 
information about each stage assigned to you. 

! Indicates if a case has been marked “Sensitive.” A case is usually 
marked sensitive if it contains allegations of suspected child abuse or 
maltreatment by an employee of the State Central Register (SCR) or a 
Local District or Voluntary Agency child welfare services worker. 
Occasionally, a Local District may choose to mark a high-profile case 
as sensitive (such as a case involving a celebrity or other public figure). 
Workers need to treat sensitive cases with special handling to guard 
confidentiality.  

Role Your role in the assigned stage. The roles that display depend on the 
type of stage. 

For CPS Investigation and FAD stages, the following roles are 
available: 

“PR” indicates that you are the Primary worker for the stage. 
“SE” indicates that you are the Secondary worker for the stage. 

For FSS stages, the following roles are available: 
“CM” indicates that you are the Case Manager for the stage. 
“CP” indicates that you are the Case Planner for the stage. 
“CW” indicates that you are a Caseworker assigned to the stage. 
“WM” indicates that you are the CPS Worker/Monitor for the 
stage. 
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Stage 
Name 

The name by which the stage is identified in CONNECTIONS. Stages 
are named after the Line 1 person (typically the mother of the children) 
in the Stage Composition for the CPS Investigation stage or the Family 
Services Stage. ACS policy for CPS-originated cases; however, is to 
assign Stage Names based on the alleged subject. In an FSS/CCR 
(Child Case Record) stage, the Line 1 person is the solitary child in the 
CCR. 

County This column displays a code representing the Local District whose 
caseworker has Primary (for CPS stages) or Case Manager (for FSS 
stages) assignment for the stage. For FAD stages, the County Code 
indicates the county where the foster home is located. 

Zone This column displays a code for New York City addresses only, 
specifying a geographical subdivision within a particular borough. 

Stage This column denotes the stage of service the selected item represents. 
One of the following stage types will display: INV, INT, FSI, FSS or 
FAD. 

Type This column displays the type of stage (e.g., “CWS” for a Child Welfare 
Services stage, “OTI” for an Out-of-Town Inquiry, “CCR” for a Child 
Case Record). 

Start This column displays the Stage Start Date, which is based on the 
Intake start date. For a FAD stage, the Stage Start Date is the date on 
which the foster home was created. 

Assigned This column denotes the date the stage was assigned to you. 

Unit This column indicates the unit to which you are assigned. 

Stage ID 
and 
Case ID 

The Stage ID and Case ID numbers are unique, system-generated 
identification numbers assigned to stages and cases, respectively. 

Stages, Types and Roles  
The Stage column indicates the type of stage that is assigned to you: 

INT  (CPS Intake) indicates that the stage still needs to be progressed to the 
Investigation stage. Multiple intake stages can exist in a CPS case, if 
there are multiple reports. 

INV  (CPS Investigation) indicates that the stage has already been progressed 
from Intake to Investigation. Multiple investigation stages can exist in a 
CPS case. 

ARI. (Administrative Review Investigation) only exists for State Central 
Register staff. 

FAD. (Foster and Adoptive Home Development) indicates a foster or adoptive 
home. A FAD case contains only one stage. 
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FSI (Family Services Intake) is where you document the reasons for opening 
up a services case (FSS). Only one FSI can exist for each case. 

FSS  (Family Services Stage) establishes a single, electronic case record, 
where caseworkers document information about children and families 
receiving child welfare services. Only one FSS per district can exist in a 
case. 

The Type column displays a specific type of stage. There are six stage types associated with a 
Family Services Stage: 

Child Welfare 
Services 
(CWS) 
 

This is the most commonly used type of Family Services Stage. It 
includes adoption, foster care, preventive and child protective services. 

Child Case 
Record (CCR) 
 

The Child Case Record is created when a child is legally freed for 
adoption. This is a separate type of FSS; every child who has been freed, 
including those who might not have a goal of adoption, has a separate 
CCR. 

Out-of-Town 
Inquiry (OTI).  

There are two types of Out-of-Town Inquiry (OTI): out-of-state and 
county-to-county. An out-of-state OTI is a written request for assistance 
or follow-up on a specific matter that usually involves a family (or family 
members) now residing in New York State. A county-to-county OTI is a 
request made by one local district to another local district for assistance 
or follow-up on a specific matter that involves a family (or family 
members) residing outside the requesting district. The request usually 
requires an action that cannot be completed by the requesting district. 

Court Ordered 
Investigation 
(COI) 
 

This type is used for a case that was initiated by a court-ordered 
investigation, rather than by a CPS investigation. 

Interstate 
Compact for 
the Placement 
of Children 
(ICPC) 
 

This type is used for cases where the local district/ACS or voluntary 
agency is receiving a child from another state (incoming). All children who 
were in foster care in New York State and are being placed via ICPC in 
another state already have an open FSS/CWS in CONNECTIONS and 
will continue to be tracked in that stage (outgoing). 

Advocates 
Preventive 
Only (ADVPO) 
 

The Advocates Preventive Only (ADVPO) type is used exclusively for 
Family Services Stages in New York City when ACS is the Case Manager 
for a preventive services case and the voluntary agency that will be 
directly providing only preventive services to the family is exempt from the 
responsibility of recording the FASP online, in accordance with the terms 
of the Advocates for Children Preventive Settlement Agreement. 

The Role column displays a code defining your role in the assigned stage. Role is very 
important in determining responsibility for work and appropriate access to information or tasks in 
a case: 

• “CM” indicates that you are the Case Manager. 
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• “CP”   indicates that you are the Case Planner. 
• “CW” indicates that you are a Caseworker assigned. 
• “WM” indicates that you are the CPS Worker/Monitor. 
• “PR”   indicates that you are the Primary worker for a FAD or CPS stage. 
• “SE”   indicates that you are the Secondary worker for a FAD or CPS stage. 

Using Staff and Case To-Do Lists 
CONNECTIONS sends you To-Do’s to notify you of actions you must take on an assigned case, 
and of events in a case, including when something has happened or is about to happen. You 
can also send To-Do’s to yourself and others 

 

Step-by-Step: 
Viewing To-Do’s on the Staff To-Do List 

1 Click on the TO-DO button on the CONNECTIONS Toolbar. 
The Staff To-Do List displays. 

2 Click on a To-Do to select it from the list. 
To view additional To-Do’s, use the vertical scroll bar. To move beyond the last To-
Do you can view with the vertical scroll bar using the mega scroll button (which looks 
like dog eared pages) that displays at the juncture of the vertical and horizontal scroll 
bar. 

3 Click on the Detail… button. 
The To-Do Detail window displays for the selected To-Do. 

4 To close the To-Do Detail window, click on the Cancel button. 
The Staff To-Do List displays. 

5 To close the Staff To-Do List, click on the Close button. 

 

 

 

 

 

 

 

Step-by-Step: 
Viewing To-Do’s on the Case To-Do List 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on a stage to select it. 
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3 Click on the Options menu on the Assigned Workload and select the Case To-Do’s 
command. 
The Case To-Do List displays with To-Do’s for the selected case. If the selected case 
has multiple stages, To-Do’s display for every stage of the case. If the Case To-Do 
command is disabled, the stage has not been accepted. Click on a To-Do to select it 
from the list. 
To view additional To-Do’s, use the vertical scroll bar. To move beyond the last To-
Do you can view with the vertical scroll bar using the mega scroll button (which looks 
like dog-eared pages) that displays at the juncture of the vertical and horizontal scroll 
bar. 

4 Click on the Detail… button. 
The To-Do Detail window displays for the selected To-Do. 

5 To close the To-Do Detail window, click on the Cancel button. 
The Case To-Do List displays. 

6 To close the Case To-Do List, click on the Close button. 
The Assigned Workload displays. 

Navigating from Task To-Do’s 
From a Task To-Do, you can navigate directly to the window needed to complete the task. For 
example, if you receive a system-generated Task To-Do notifying you that the Safety 
Assessment is due, you can navigate directly to the Safety Assessment window for that stage. 
This feature is available only for Task To-Do’s. 

 

Step-by-Step: 
Navigating from Task To-Do’s 

1 Open the Staff To-Do List or Case To-Do List. 
2 Click on a Task To-Do to select it from the list. 

The Navigate… button enables. 
3 Click on the Navigate… button. 

The task-related window associated with the selected To-Do displays. 
4 If you make changes on that window, save your work by clicking on the Save button. 
5 To close the window without saving changes, click on the Cancel or Close button. 

The To-Do List displays. 
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Reminder To-Do’s 
You can create Reminder To-Do’s from either the TO-DO button or the WORK button on the 
CONNECTIONS Toolbar. 

 

Step-by-Step: 
Creating a Reminder To-Do 

1 Click on the TO-DO button on the CONNECTIONS Toolbar. 
The Staff To-Do List displays. 

 
If you must send  

confidential information to 
another worker, you should 

do so by sending a 
Reminder-To-Do, rather than 

an e-mail message. 

2 Click on the New button. 
The To-Do Detail window displays. The Short Desc 
field highlights in yellow, indicating that comments are 
required in that field. 

3 Record a brief description in the Short Desc field. 
Examples of the type of information to include in this 
field are the Stage Name, Stage ID or Case ID 
number, a topic and your name (e.g., “Mary Smith - 
Stage #98765432 – Review Progress Notes by Darryl 
Wilson”). 

4 Add an additional explanation, if necessary, in the Description/Notes field. 
5 If appropriate, record the correct due date in the Due field. 

 
To create a Reminder To-Do 
from the Assigned Workload: 

1 Click to select the stage for 
which you want to create a 
To-Do. 

2 Click on the Options menu 
and select the Case To-Do’s 
command. 
The Case To-Do List 
displays. 

3 Click on the New button. 
The To-Do Detail window 
displays. 

Continue with Step 3 in 
“Creating a Reminder To-Do” 

at left. 

6 If you are sending the Reminder To-Do to yourself, 
skip to Step 10. 
—OR— 
If the Reminder To-Do is for another person (e.g., 
your supervisor), click on the Staff button. 
The Staff Search Criteria window displays. 

7 Enter the person’s last name in the Last Name field. 
The Search button enables. 
If you are searching for a worker outside your 
agency, enter that worker’s agency code in the 
Agency field. 

8 Click on the Search button. 
The Staff List displays with the results of the search. 

9 Select the appropriate worker from the Staff List. 
10 Click on the OK button. 

The To-Do Detail window displays, with the selected 
staff person’s name in the Assigned To field. 

11 Click on the Save button. 
The new To-Do is saved and displays on the Staff 
To-Do List of the person to whom the To-Do was 
sent. 

12 To exit the Staff To-Do List, click on the Close button. 
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The Event List 
There are two types of Event Lists in CONNECTIONS—one for a stage and one for a case. 
Each Event List contains CONNECTIONS tasks and case/stage-related activities that have 
been completed or are in progress. Events are generated to the list, for example, when you 
receive a new assignment, or when your supervisor approves or rejects work that you’ve 
submitted. 

The Event List is available for you to keep track of the progress of work on a stage and, in some 
situations, to view details of specific events. The Event List includes two date columns. 

The Event Date displays the date an event was completed based on either of the following: 

• The date you recorded and/or saved the information in the system (e.g., the date a 
CPS Intake was created and saved). 

• The date recorded in the date field of certain windows (e.g., the Safety Factors tab of 
the Safety Assessment for CPS stages). 

• To view the status of supervisory decision.  

The TX Date is the system-generated date an event was updated by using one of the Save 
functions (e.g., Save or Save and Submit).  

Some events are generated as “complete” (e.g., assignments and notification letters); both the 
Event Date and the TX Date for these events correspond to the date on which the event was 
generated. 

Event Status 
The Event List includes a Status column, denoting the status of each event: 

NEW An event has been generated but no work has been saved 
(e.g., a Safety Assessment in an Investigation stage that has not been 
accessed). 

PROC The item is in process. Work has been saved but not yet completed (e.g., 
some Risk Assessment Profile information entered by worker but not 
ready to be submitted for supervisory approval). 

COMP Work has been completed and saved, but not yet submitted for approval 
(e.g., an Investigation Conclusion that is completed and saved but not yet 
submitted for supervisory approval). This status also displays for events 
that do not require submission.  

PEND Work has been submitted and is pending approval (e.g., a Safety 
Assessment that has been Saved and Submitted, but which the 
supervisor has not yet approved or rejected). 

REJT The supervisor has rejected the submitted work. You must correct the 
affected item (e.g., Safety Assessment, RAP) and re-submit it. 
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APRV The submitted work has been approved by the supervisor (and any 
additional approvers, if applicable). Upon approval, the event is “frozen” 
along with all of its related windows (e.g., the supervisor has approved an 
Investigation Conclusion). 

SUSP The Investigation stage has been closed as a duplicate (and the Safety 
Assessment was never approved by the supervisor). If the Investigation 
was closed as Fatality – No Surviving Children, the status of the RAP 
changes to SUSP, unless the RAP was previously approved by the 
supervisor. 

 

 

Step-by-Step: 
Viewing the Event List from the Workload 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on a stage to select it. 
3 Click on the Options menu and select the Event List… command. 

The Event List displays for the selected stage. 
 

 

Step-by-Step: 
Opening the Event List for a Case from Case Search 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Write down the Case ID number from the stage for which you want to view the Event 
List. 

3 Click on the CASE button on the CONNECTIONS Toolbar. 
The Case Search Criteria window displays. 

4 Enter the Case ID number in the Case ID field. 

5 Click on the Search button. 
The Case List displays the case that matches the search criteria. 

6 Click on the case to select it. 

7 Click on the Events… button or the Event List command on the Options menu. 
The Event List displays for the selected case. 
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Navigating from the Event List 
From the Event List you can navigate to a specific window to view specific tasks. By clicking on 
the detail button the Event List, CONNECTIONS will bring you to the specific window related to 
that task.  

 

Step-by-Step: 
Navigating from the Event List 

1 Click on an event to select it from the Event List. 
If there are details to view, the Detail… button enables. 

2 Click on the Detail… button. 
The task-related window associated with the selected event displays. For example, if 
you select an event related to a Safety Assessment, clicking on the Detail… button 
opens the Safety Assessment window. 

3 To close the window, click on the Cancel button. 
The Event List displays. 
 

The Child Protective Record Summary (CPRS) 
As you navigate through the Event List you will see that as a CPS worker some of the 
information that you document for an investigation is completed on the Child Protective Record 
Summary (CPRS) window. This window consists of multiple tabs that allow you to access, view, 
modify and print CPS case information easily. You can record some information in the CPRS—
such as progress notes, Local Protocol, the Safety Assessment and the Risk Assessment 
Profile (RAP)—but most of the information contained in the CPRS is view-only and can only be 
modified via other CONNECTIONS windows. 
The CPRS is organized to be consistent with the investigation process. Supervisors also use 
the CPRS to review case information and their workers’ progress notes. Follow your local 
guidelines when documenting your casework. 

Accessing the Child Protective Record Summary 
When an Investigation stage is open, the Child Protective Record Summary window can be 
accessed in two ways: from the Task List and from the Event List. When an Investigation stage 
is closed, the Child Protective Record Summary window can only be accessed from the Event 
List. (Note that windows accessed from the Event List are in view-only mode). 
All state and local district staff with the appropriate Business Function Profile (BFP) are able to 
view the CPRS for a particular investigation. The ability to update the information in CPRS is 
limited according to your role in the stage and whether the stage is open or closed. 
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Step-by-Step: 
Accessing the Child Protective Record Summary from the Task List  

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select the INV stage from the list. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays for the selected INV stage. 

4 Click on the Child Protective Record Summary task. 
The Detail… button enables. 

5 Click on the Detail… button. 
The CPRS window displays for the selected stage. 
 

 

Step-by-Step: 
Accessing the Child Protective Record Summary from the Event List 

1 Click on the Work button on the CONNECTIONS 
Toolbar. 
The Assigned Workload displays. 

 
Refer to Viewing the Event List 
Step-By-Step instructions on 

page 19 of this guide and follow 
steps 2-7. 
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Viewing Information in the Child Protective Record Summary 
The Child Protective Record Summary (CPRS) window is organized into three sections. The 
Header (top portion of window), the Tab Section (middle portion) and the Footer (lower window). 
The Header includes the following information: Case Name, Case ID, INV Stage ID (refers to 
the stage that was highlighted on the Assigned Workload when the CPRS was opened), Report 
Date, CD (Community District; NYC only), High Priority (NYC only) and Fatality Report. The 
Fatality Report information only displays if a DOA/Fatality allegation is present in the stage.  
 

 
 
The CPRS footer displays four buttons: Intake Narrative, Help on Narratives, Generate Report 
and Close. 
The Intake 
Narrative button 

View the narrative recorded at intake.  

The Help on 
Narratives button 

Provides access to the CPRS Online Help function 

The Generate 
Report button  

Opens the Generate Report window. From this window, you can select 
the specific CPRS tab(s) you want to print by clicking on the 
corresponding checkbox(es); to print all information in the CPRS (except 
progress notes), click on the Select All checkbox. Keep in mind that if 
you select the Safety Assessments (All) checkbox, all Safety 
Assessments for this stage will print. 

The Close button Will close the CPRS window and return you to the window in which you 
entered the CPRS, either the Task List or the Event List.  
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The Tab Section of the CPRS is separated into nine major areas that make up each tab. Tabs 
appear, from left to right, in the following order: 

• Case Identification 

 

The Case Identification, 
Household Composition, 

Allegations,  
Investigative Actions and 

Investigative Findings tabs are 
view-only. To update the 

information on any of these 
tabs, you must close the CPRS 

and open the appropriate 
CONNECTIONS window(s). 

CPRS Help provides the path to 
the appropriate window(s). 

• Household Composition 
• Allegations 
• Investigative Actions 
• Investigative Findings 
• Local Protocol 
• Safety Assessment 
• Risk Assessment Profile (RAP) 
• Progress Notes 
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The Foster and Adoptive Home Record Summary (FRS) 
As a FAD worker you can navigate from the Event List to the Foster and Adoptive Home Record 
Summary (FRS) to view specific tasks. The FRS provides you a comprehensive view of the 
FAD information you have recorded in CONNECTIONS. This window is similar to the CPRS as 
it consists of multiple tabs that allow you to access, view, and print FAD home information 
easily. This window is organized to be consistent with the existing foster/adoptive home 
development process. Comments and contact notes may be recorded at appropriate points 
throughout this process. 

Currently, not all of the information you see in the FRS can be updated within the FRS. Some of 
the information presented in the FRS is drawn from other CONNECTIONS windows, and can 
only be updated in those windows. Some tabs do allow for the recording of various types of 
comments and notes. The Home Study Narrative and Annual Reauthorization tabs allow for the 
creation and editing of narratives directly within the FRS.  

The layout of the FRS is similar to the CPRS Window.  Information in the FRS is organized into 
three sections; the Header (top portion of window), the Tab Section (middle portion) and the 
Footer. 

 

 

The Header is always present when the FRS is open. It includes the following information:  

• Resource Name 
• Authorized From Date 
• Vendor ID 
• Resource ID 
• Authorized To Date 
• Agency Name/Resource ID 
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The FRS footer displays four buttons:  

Submit  This button initiates the Save and Submit process. Clicking the Submit 
button opens the F/A Home License window, allowing you to Save and 
Submit the FRS and the Home license information together The 
Submit button is disabled when the FRS is entered in view-only mode 
or if no information has been saved to the FRS 

Help on Narratives  This button provides access to help information on how to use the 
Home Study and Annual Reauthorization documents.  

Generate Report  This button opens the Generate Report window. This window allows 
you to choose any or all of the FRS tabs to be formatted into a single 
document that can be printed. 

Close  This button will close the FRS. The window from which the FRS was 
entered; either the Task List window or the Event List window displays. 

 

The home information of the Tab Section is separated into nine tabs. 

• Home Demographics  
• Licensing Information  
• Household Member Detail  
• Home History Events  
• Agency/Worker Information 
• Home Study Narrative 
• Annual Reauthorization Narrative 
• FAD Checklist 
• Contacts 

Accessing the FRS  
The Foster and Adoptive Record summary window can be accessed in two ways: from the Task 
List and the Event List. The primary reason for accessing the FRS via the Event List is to view a 
Home Study or Annual Reauthorization narrative.  

Events with a status of PROC, PEND, or REJT allow view-only access to the current FRS. 
Events with a status of APRV allow view only access to frozen/approved Home Study or 
Reauthorization documents. 

 

Step-by-Step: 
Accessing the FRS from the Task List 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 
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2 Select a FAD stage from the list. 
The Tasks…button enables. 

3 Click on the Tasks…button. 
The Task List displays for the selected home. 

4 The FAD Task List contains three tasks that can open the FRS window. Select the 
task that best reflects why you are opening the FRS. 
For example, select Annual Reauthorization when you need to complete the Annual 
Reauthorization Document. 

 

 

Step by Step: 
Accessing the FRS from the Event List 

1 Click on the Work button on the CONNECTIONS 
Toolbar. 
The Assigned Workload displays. 

 
To access the FRS for a stage 

that is not on your Assigned 
Workload, follow the Step-by-

Step instructions on opening the 
Event List for a Case from Case 
Search on page 19 of this guide.  

2 Select a FAD stage from the list. 
3 Click on the Options menu. 

A menu displays. 
4 Click on the Event List command. 

The Event List window displays. 
5 Select the appropriate “navigable event,” and click 

on the Detail… button. 
The FRS displays in view-only mode. 
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Family Services Intake 

The Family Services Intake is the method by which you document the reasons for opening a 
services case (Family Services Stage). For both CPS and non-CPS Child Welfare cases, an 
explanation of the family’s presenting needs and circumstances that warrant the provision of 
services and the progression of an FSI to an FSS is needed. For CPS cases, the person 
demographic information recorded in the CPS Investigation stage carries forward to the FSI, 
whether the Investigation is Indicated or Unfounded. The Intake Source is system-populated 
with the Primary worker’s information from the CPS stage (or the Secondary worker, if s/he 
creates the Intake during an in-process Investigation). 
Information must be recorded in CONNECTIONS before a Family Services Stage (FSS) can be 
opened. Whether you are a local district/ACS worker or a voluntary agency (VA) worker (with 
the proper security rights) you can record Family Service Intakes. 
Once all the required information is recorded, the FSI may be stage-progressed and a Family 
Services Stage (FSS) may be opened; or, conversely, the FSI stage may be closed if services 
are not to be provided. 
Information captured in the FSI includes: 

• Source of Intake 
• People in need of services 
• Type(s) of services being requested 
• Presenting concerns 
• Issues requiring emergency or crisis services 
• Actions necessary to deal with emergency or crisis situations 
• A decision concerning the provision or denial of services 
• Programmatic Eligibility for Mandated Preventive Services 
• Behavioral Concerns and Family Issues (BCFI) for non-Protective Child Welfare 

Services 

Creating an FSI 
There are several paths you may take to create an FSI. The paths available are contingent on 
your role and assigned Business Functions, and whether the stage is originating from a CPS 
Investigation or a non-Protective Child Welfare request for services. A CPS worker can open an 
FSI during the Investigation of a CPS report (via the Assigned Workload); an FSI automatically 
opens upon the approval of a CPS Investigation Conclusion when the CPS stage is closed with 
an open for services Closure Reason. For non-Protective cases, a worker can create an FSI 
from the CONNECTIONS Toolbar. 
Automatic opening is based on an Investigation Conclusion with one of the following Closure 
Reasons: 

Unfounded CPS Report:  
• Case Open-Services 

Indicated CPS Report: 
• Case Open-CPS not required 
• Case Open-CPS required 

A Record Family Services Intake event is added to the Event List in view-only mode when an 
FSI is opened regardless of the path used to create the FSI. 
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Step-by-Step: 
Creating the FSI from an Open CPS Investigation  

1 Click on the WORK button on the CONNECTIONS 
Toolbar. 
The Assigned Workload displays.  

2 Select an INV stage for which you will create an FSI. 
3 Click on the Options menu and select Record 

Family Services Intake. 
The Family Services Intake stage displays on the 
Assigned Workload. 

 

Step-by-Step: 
Creating an FSI from the CONNECTIONS Toolbar  

1 Click on the Intake menu.  
2 Select the Record Family Services Intake 

command. 
The Family Services Intake window displays with 
the Intake Source tab active. You must select an 
Intake method in order for the source demographic 
information to enable. 

 

Step-by-Step: 
Viewing an FSI from the Case List  

 
The Create FSI Business 

Function is required to enable 
the Menu item Record Family 

Services Intake. 

 
When creating the FSI from the 
CONNECTIONS Toolbar, the 

intake date on the Intake 
Source tab can be back dated 
up to 60 days.  When the FSI is 

stage progressed, the Event 
Date of a progress note cannot 
be prior to the Intake date of the 

FSI. 

 
For details about the Case 
Search functionality, see 

“Case Search” in Module 1: 
CONNECTIONS Basics. 

1 Conduct a Case Search to find the case.  
The Case List displays. 

2 Select the case from the Case List.  
3 Click on the Events button to open the Event List for 

the selected case. 
4 Select the Record Family Services Intake event. 
5 Click on the Detail… button. 

The FSI displays in view-only mode with the 
Decision Summary tab active. 
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The Family Services Intake Window 
The Family Services Intake window features a standard header, four tabs and various buttons 
within each tab. The header is always visible when the FSI window is open, regardless of which 
tab displays. The header includes the Case Name and Sensitive Case indicator, if applicable. 
The Stage ID and Case ID display in the title bar. 

 
The FSI window contains the following four tabs, which are view-only when the FSI is accessed 
through the Event List: 

Intake Source This tab supports the recording of the intake date and modifying of 
demographic information regarding the individual or agency that 
referred the family for services. 

Narrative This tab captures information supporting the request for services. This 
tab features an evaluation of behavioral concerns and family issues that 
were presented or identified. The narrative is frozen after each save. 

Person 
Demographics 

This tab provides for the recording/modifying of demographic 
information concerning the individuals/family for whom services are 
being requested. This tab includes address and phone updates, and 
the addition or removal of people in the FSI. Workers should conduct 
person maintenance for data integrity purposes. 

Decision 
Summary 

This tab is used to record a recommendation regarding whether a 
Family Services Stage should be opened or if the FSI stage should be 
closed without opening an FSS. It also includes a statement about 
Programmatic Eligibility, application dates, etc. 
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The footer of each FSI tab contains standard Save, Cancel and Close buttons; these 
commands can also be accessed from the File menu. Once an FSI is submitted for review 
(using the Submit for Review function), the reviewer can modify information in the FSI except 
for the Intake Source tab and the Narrative. (The Narrative can be added to, but any previous 
Narrative entries cannot be modified.) When the FSI is submitted to the Local District for 
acceptance, it cannot be modified unless the Local District worker accepts the FSI; once that 
occurs, information in the FSI can be modified except for the Intake Source tab and the 
Narrative. As with the Submit for Review function, the Narrative can only be added to, not 
modified. If the FSI is reassigned back to a worker by a supervisor or a Local District for more 
information, the fields are again modifiable. 

Stage Progression to a Family Services Stage 
Stage Progression is the process that allows for an FSI stage to be closed and a Family 
Services Stage (FSS) opened so services can be provided to a family. Only a local district/ACS 
worker can stage progress an FSI to an FSS. A new FSS is created within the existing case and 
is reflected on the workload of the local district/ACS worker who initiated the progression.  
The only CONNECTIONS role available in an FSI is Caseworker; only one person is assigned 
to an FSI at a time. This person is the worker who created the FSI; this is not necessarily 
reflective of a specific job title (e.g., clerical worker). Once the local district/ACS worker stage 
progresses the FSI to FSS, the local district/ACS worker automatically becomes the Case 
Manager in the FSS.  
S/he can reassign the Case Manager role for that FSS to another local district/ACS worker. The 
Case Manager can assign a local district/ACS or voluntary agency worker as Case Planner or 
Caseworker. 
More than one district may be providing services for a family at the same time; leading to an 
open FSI stage in other districts under the same Case ID. If an open FSI stage exists in another 
district, an alert is sent to the Case Manager and the Case Planner to notify them that the family 
is requesting services in a different district. One district may choose to retain Case Management 
for a case; workers in another district can be assigned a role of Caseworker only. 
The following FSI forms and reports are available: 

Family Services Intake 
Report 

This report displays all information recorded in the 
FSI. 

FSI Denial Letter This letter serves as notification that a request for 
services has been denied (not applicable to cases 
originating from a CPS Investigation). 

Family Services Face Sheet This report is an overview of case, worker and stage 
composition information. 

Family Services Intake Log This report lists Intake activity within a specified time. 
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Step by Step: 
Creating a Family Services Stage 

1 Select an FSI stage on the Assigned Workload. (This is found in the Decision 
Summary tab of the FSI). 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Family Services Intake window displays. 

3 Click on the Decision Summary tab. 
4 Click on the Create Family Services Stage (Stage Progression) button. 

The following message displays: “The FSI will be closed and an FSS stage will be 
opened. Do you want to continue?” 

5 Click on the Yes button. 
The following message displays: “Create Family Services Stage Successful.” 

6 Click on the OK button. 
7 Click on the Close button. 

The CONNECTIONS Toolbar displays. 
8 Click on the WORK button. 

The Assigned Workload displays. The FSI is no longer on the Assigned Workload; a 
new Family Services Stage displays.  

9 Click on the Close button. 
The CONNECTIONS Toolbar displays. 
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Family Services Stage  

Once a Family Services Intake (FSI)—whether from a CPS or non-CPS source—is progressed 
to a Family Services Stage (FSS), workers in both the local district and Voluntary Agency 
involved in that stage document their casework activities in that electronic case record. (For 
more information about the FSI, refer to the previous module: Family Services Intake.) With all 
child welfare professionals working from the same electronic case record, a comprehensive 
view of the services development and delivery process is maintained regarding the children and 
adults involved in the case. 

 
In order to distinguish among 
the FSS types, this document 

refers to the stage and its 
respective type,  

where appropriate: 
  FSS/CWS 
  FSS/CCR 
  FSS/OTI 
  FSS/COI 
  FSS/ICPC 
  FSS/ADVPO 

The FSS provides for the documentation of casework activities, 
including progress notes, safety and risk assessments, as well as 
services that have been requested, determined to be needed and/or 
provided. CONNECTIONS supports the child-centered, family-
focused Case Management model for Child Welfare practice in New 
York State by providing the documentation framework in the FSS. 
The FSS contains all documentation related to the Family 
Assessment and Service Plan (FASP), to which all of the workers 
involved in the case contribute. This practice requires coordinated 
efforts among child welfare professionals in Local Districts and 
Voluntary Agencies, as appropriate. 

Stage Types  

An FSS can be one of the following Types: 

Child Welfare Services 
(CWS)  

This is the most commonly used type of Family Services Stage. It 
includes adoption, foster care, preventive and long-term protective 
services. 

Child Case Record (CCR)  The Child Case Record is created when a child is legally freed for 
adoption. This is a completely separate type of FSS; every child 
who has been freed, including those who might not be placed in an 
adoptive setting, has a separate CCR. Each CCR will also have its 
own corresponding Welfare Management System (WMS) case. 

Out-of-Town Inquiry (OTI)  There are two types of Out-of-Town Inquiry (OTI): out-of-state and 
county-to-county. An out-of-state OTI is a written request for 
assistance or follow-up on a specific matter that usually involves a 
family (or family members) now residing in New York State. A 
county-to-county OTI is a request made by one Local District to 
another Local District for assistance or follow-up on a specific 
matter that involves a family (or family members) residing outside 
the requesting district. The request usually requires an action that 
cannot be completed by the requesting district. 
 

Court Ordered Investigation 
(COI)  

This type is used for a case that was initiated by a court-ordered 
investigation, rather than by a CPS investigation. 
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Interstate Compact for the 
Placement of Children 
(ICPC) 

This type is used for cases where the Local District or Voluntary 
Agency is receiving a child from another state. All children who 
were in foster care in New York State and are being placed via 
ICPC in another state already have an open FSS/CWS in 
CONNECTIONS and will continue to be tracked in that stage. 

Advocates Preventive Only 
(ADVPO)  

The Advocates Preventive Only (ADVPO) type is used exclusively 
for Family Services Stages in New York City when ACS is the 
Case Manager for a preventive services case and the Voluntary 
Agency that will be directly providing only preventive services to 
the family is exempt from the responsibility of recording the FASP 
online, in accordance with the conditions of the Advocates 
Preventive lawsuit settlement. 

 

Accessing the FSS 
Your ability to access and maintain the FSS depends on a variety of factors including: 

• your current or historical role in the stage. 

• the Business Functions that have been assigned to you. 

• the Agency Access and Organizational Hierarchy your district/agency has established in 
CONNECTIONS. 

If you have a role in the stage, you can access the FSS from your Assigned Workload and 
maintain all necessary components of that stage that are appropriate for your role. You may be 
assigned one of four roles in an FSS: 

Case Manager Every FSS has a Case Manager, who must be a Local District 
worker. An FSS can have only one Case Manager at any given 
time. The Case Manager provides oversight of the case and 
approves the FASP. When the Case Manager acts as the Case 
Planner, the Case Manager’s supervisor must approve the FASP. 

Case Planner The Case Planner submits the FASP to the Case Manager for 
approval and alerts the CPS Worker/Monitor in circumstances 
where that individual needs to complete or review the FASP. 
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Caseworker One or more Caseworkers (who can be either Local District or 
Voluntary Agency staff) may be assigned to an FSS. The 
Caseworker role in an FSS stage may be assigned cross-district by 
a Local District Case Manager or a Local District Case Planner. 
Caseworkers who are assigned to an FSS complete work within the 
FASP, such as the Family Scales. A Caseworker may be 
responsible for a specific child, multiple children or no children in 
the FSS. A Caseworker can also be Associated to a specific child or 
children. A Caseworker who has been Associated to a specific child 
can complete the Child Scales and Foster Care Scales for that 
child. Associating a Caseworker to a specific child does not prevent 
other workers from working with that child or completing other parts 
of the FASP that may relate to that child in the overall Service Plan. 
(See “The Associate Worker Tab” in Module 6: Tracked Children 
Detail.) 

CPS Worker/ 
Monitor 

The CPS Worker/Monitor is responsible for overseeing case 
activities when: 

• the case was opened from an Indicated CPS 
Investigation stage; and 

• the CPS worker is not the primary service provider 
for the case; and  

• ongoing protective concerns have been identified. 

These activities include reviewing safety-related and risk-reduction 
actions and activities, determining that appropriate services are 
being provided, and modifying the service plan when the child’s or 
family’s progress is not sufficient to meet the desired outcomes 
identified in the plan. 

Aside from your role in an FSS, you can also access the FSS in any of the following 
circumstances: 

• If you have an historical role in a CPS Intake (INT), CPS Investigation (INV), or 
Administrative Review (ARI) stage that is currently closed, you can view all of the FSS 
stages associated with the case that existed before your assignment ended. 

• If your district or agency has established Agency Access that permits view-only or 
maintain access to FSS stages, you can access those stages until Agency Access is 
changed to remove such access. 

• If you have been assigned the ACCESS ALL DIST (Access All in District) or ACCESS 
ALL AGY (Access All in Agency) Business Function, you can view all of the FSS stages 
in your district or agency. 

• If you have an Implied role in the FSS (because you have a role in a separate case that 
shares a person in common with the FSS), you can view all of the information for the 
case in which you have an Implied role. If you are a Voluntary Agency worker, you will 
not be able to access any information in the CPS Intake or Investigation stage. 

• If you are in the unit hierarchy of a worker who has a role in the FSS and you have been 
assigned the UNIT SUM ACCESS Business Function, you can access information in 
that FSS via the Unit Summary window. 
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You can access the FSS through: 
• the Assigned Workload (if you have a role in the case or access to the Assigned 

Workload of a worker with a role in the case); or 
• the Event List (view-only). 

 

Step-by-Step: 
Opening the Family Services Stage from the Assigned Workload 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the FSS you want to access. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Family Services Stage window displays. 

 

Step-by-Step: 
Opening the Family Services Stage from the Event List 

1 After conducting a Case Search (see the tip box at 
right), select the appropriate case from the Case 
List. 

 

Where am I? 

CONNECTIONS Toolbar > 
Case button > Case Search 

Criteria > Case List. 

2 Click on the Events button. 
The Event List displays. 

3 Select the Family Services Stage opened event. 
4 Click on the Detail button. 

The FSS displays for the selected event. 
In order to view a FASP through the Event List, 
select the FASP Submitted for Approval Event, and 
click on the Detail button. 
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The Family Services Stage Window 

 
The Family Services Stage window is divided into three sections: 

• Header 
• Tabs 
• Footer 

The Stage Name, Case ID number and Stage ID number display in the title bar.   

The majority of the information on the Family Services Stage window is divided into tabs: 

Family 
Assessment 
and Service 
Plan (FASP) 

This tab provides access to the Family Assessment and Service 
Plan window, from which you can access all current and historical 
Family Assessment and Service Plans (FASPs) for the FSS. The 
FASP contains the electronic documentation of assessments and 
service planning for the case. You use this window to record the 
main components of assessment and service planning for the FSS. 

Service Plan 
Review 

This tab provides access to the Service Plan Review window, which 
allows you to record or view the results of the Service Plan Reviews 
for all FASPs associated with the stage. The Service Plan Review is 
a meeting of key participants to develop and review the Service 
Plan, including Outcome and Activity statements. Key participants 
include individuals involved in the FSS, assigned workers and/or 
outside participants (such as foster parents and service providers). 

Service Plan Review documentation is important for keeping 
everyone, including the family, on the same page toward achieving 
the goals and outcome. 
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Progress 
Notes 

In order to maintain a contemporaneous and comprehensive view 
of the activities occurring in an FSS, workers need to record and 
view Progress Notes. This tab provides access to the Progress 
Notes window, which workers use to create, modify, copy, search, 
sort, view, print and record addenda to Progress Notes. (Workers 
can also delete “Draft” notes.) This window is also useful for 
monitoring required casework contacts and creating reports. 

Key Dates This tab is only enabled for 
stages that were closed prior 
to the implementation of 
Build 18.7 (December, 
2005). The Key Dates 
window no longer receives 
updates from CCRS and 
instead displays the last data 
received from CCRS prior to 
the implementation of Build 
18.7.  
 
 
 

 
This process of updating Key Dates in 

CCRS (and the accompanying 
CCRS-CONNECTIONS batch update 
process continues only until Build 19 
is implemented; after that, Key Dates 

will be recorded directly in 
CONNECTIONS. 

 

Case Summary Provides access to the Case Summary window, which displays all 
of the stages (open or closed) that are part of the case. This 
window also displays the names of workers who are currently 
assigned to active stages (or historical workers if the stage is 
closed). However, CPS Intake and Investigation stages will not 
display for Voluntary Agency workers. 

The Case Manager or Case Planner uses the Case Summary 
window to initiate the stage closing process and, in certain 
situations, to change the stage type. 

For some FSS types (OTI, COI, ICPC and ADVPO), the following tabs are disabled: 

• Family Assessment and Service Plan 
• Service Plan Review 
• Key Dates 
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Maintaining Person Information 

Finding Information about a Person in CONNECTIONS 
The CONNECTIONS database includes information about individuals associated with child 
protective cases, Family Services Intakes, Family Services Stages, as well as foster care 
providers, state and local district staff, and voluntary agency personnel.  
Person Search is a tool for locating information about people in CONNECTIONS, to determine if 
a person is known to CONNECTIONS, and to find specific information on a person.  
 
Once a search is performed, the Case List button on the Person Search window provides a 
method of accessing the selected person’s case information. This information can also be 
accessed from the Option menu. 
CONNECTIONS information needs to be maintained in a 
secure, accurate and reliable manner, but also be readily 
available for use by workers needing information. 

 
Persons will not be identified as 
sources or reporters in a Person 

Search, even if they are listed 
as members of the household. If 

a reporter is also a principal, 
Person Search returns the 

principal information only. For 
example, if a mother is the 

source of a report of child abuse 
or maltreatment regarding her 
child and the child’s father, she 

is both the reporter and a 
principal in the case. A Person 

Search on the mother only 
returns information identifying 

her as a principal, not as a 
reporter 

Routes to the Person Search Window 
Person Searches can be conducted from the Person Search 
window. You can always conduct a Person Search from the 
CONNECTIONS Toolbar, however, if you are working on a 
case that is in the Investigation stage (INV) or Foster/Adoptive 
Home Development stage (FAD) you would most often conduct 
a Person Search through your Assigned Workload, using the 
Maintain Person task. This enables you to maintain 
information (e.g., add or relate a person) for that stage. As the 
assigned worker, your role in the case determines your access 
and your ability to maintain data. If you are working on an FSI, 
you can conduct a person search through Person 
Demographics; and if you are in an FSS the person search can 
be conducted through the Stage Composition tab. 
Search results may include more than one possible match for your search criteria. Explore all 
possible matches. The individual you are searching for may be listed more than once in the 
database. Review the information in the Person Search List to determine if the person you are 
searching for matches one or more of the results on the list. Look at the demographics listed in 
the Person Search List to help you make this determination. If you don’t have enough 
information to determine whether or not you have found a proper match, you can access more 
information about a person in the Person Search List by looking at other cases with which that 
person has been involved. This process is sometimes called “drilling down.” 

On occasion, you may need to search for an individual from the CONNECTIONS Toolbar. This 
is beneficial when you are not the assigned worker, but need information on a person or case. 
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Step by Step: 
Conducting a Person Search from the CONNECTIONS Toolbar 

1 Click on the PERS button on the CONNECTIONS 
Toolbar. 
The Person Search window displays. 

2 Enter the person’s first and last name in the name 
fields. 

3 Enter the date of birth or approximate age, if known, 
into the DOB or Age fields. 

4 The Person Search window automatically defaults to 
Phonetic Name search. To conduct an Exact search, 
click the drop-down arrow for the Search Type field and select Exact. 

5 Click on the Search button. 
CONNECTIONS performs a search based on your criteria and returns the results of 
your search in a list at the bottom of the Person Search window. Use the scroll bar to 
scroll down the list. Use the mega scroll to view results beyond the last row visible 
using the vertical scroll bar. 

6 Review the results and determine if any match is the person you are searching for. 
You may need to revise the search, depending upon your results. Instructions on 
how to revise a search follow. 

7 If your search resulted in no matches, the following message displays on the Person 
Search List title bar: “Person Search List - No Results Returned.” You can try the 
search again with broader or different search parameters. 

 

Step-by-Step: 
Opening the Person Search Window Within a FAD or INV Stage 

 

CONNECTIONS calculates the 
age from DOB information. If 

you don’t know the exact date of 
birth, enter an approximate age. 

 

The Maintain Person 
task is available only for 
Investigation (INV) and 
Foster/Adoptive Home 

Development (FAD) 
stages. 

1 Click on the WORK button on the 
CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on a stage to select it. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

4 Click on the Maintain Person task. 

5 Click on either the New or List… button. 
The Person List displays. 

6 Click on the New button. 
The Person Search window displays. 
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Step-by-Step: 
Opening the Person Search from a Family Services Intake (FSI) 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on an FSI stage to select it. 
The Tasks…button enables. 

3 Click on the Tasks…button. 
The Family Services Intake window displays. 

4 Select the Person Demographics tab. 

5 Enter the person’s first and last name in the name fields. 

6 Enter the sex in the Sex drop down field..  
The Add Person button enables. 

7 Click on Add Person button. 
The person you have added now appears in the Name box at the bottom of the 
window. 

8 Highlight the person you added and click on the Search button. 
The Person Search window displays. 

 

Step-by-Step: 
Opening the Person Search from a Family Services Stage (FSS) 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the FSS stage to select it. 
The Tasks…button enables. 

3 Click on the Tasks…button. 

4 The Family Services Stage window displays with the Stage Composition tab 
displayed. 

5 Click on the Add/Relate button. 
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Conducting Person Searches in a CPS Stage 
Throughout your investigation, there will be occasions which require you to look up information 
about people associated with your assigned case. This includes all current and/or historical 
cases in which these individuals were involved. The following individuals need to be included in 
the Person List for an Investigation stage: 

• Subject(s), including Parent(s) and Guardian(s) of victim child(ren); and other 
person(s) 18 years of age or older responsible for the victim child(ren)’s care at the 
relevant time; 

• Abused/Maltreated Child(ren); and 
• all other children living in the household. 

 

Conducting Person Searches in a FAD Stage 
During the life cycle of a foster or adoptive home, you may need to add people to the Person 
List for that home. Every individual residing in the foster or adoptive home must be added to the 
Person List, and all known information about that person must be documented in 
CONNECTIONS.  

Below are situations that require you to add individuals to the Person List for the home/stage: 

• Following an adoption finalization, the adopted child must be added to the Person 
List and identified as a “son” or “daughter;” 

• When a single foster parent marries, or a significant other moves into the household, 
the new individual must be added to the Person List; 

• When a foster child has his/her 18th birthday, the child must be added to the Person 
List and identified as a “Foster Child;” 

• When any individual (e.g., aunt, uncle, grandparent, niece, nephew) age 18 or older 
moves into the home on a temporary or permanent basis, that individual must be 
added to the Person List. 
 

Conducting Person Searches in an FSI Stage 
If an FSI has originated from a CPS INV stage, information will pre-fill within the Person 
Demographics tab including, the name, address, sex, date of birth, race/ethnicity, etc. The 
Person List of the FSI members will display in this tab. 

A Person Search may be conducted at any time on an individual until the FSI is closed and an 
FSS is opened. Depending on your security functions you may add, delete or modify data on 
this tab until the FSI is closed. Future modifications will be made in the FSS if the case is 
“Open” for services. 
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As in an INV stage, the default search type from the FSI is Phonetic Name. When you are 
adding a person, an automatic Phonetic Name search initiates based on the information 
recorded on the Person Demographics tab. A person search must be conducted on all 
persons in an FSI, except those the system carried forward from a CPS Investigation. Person 
demographics generated from a CPS stage automatically populate; you should verify this 
information and make any necessary changes. 

Conducting Person Searches in an FSS Stage 
Once a stage is progressed to an FSS, the information that was recorded in the FSI will 
automatically pre-fill into the Stage Composition tab. The Stage Composition tab lists all of 
the individuals involved in the FSS, as well as their demographics, identifiers, address and 
phone information. You are able to maintain the information via buttons on the tab or by typing it 
directly into the fields 

As information changes about one or more individuals, or about the family as a whole, it is 
important for you to keep the information up-to-date in the electronic case record.  

The Stage Composition tab allows you to add to or modify the composition of the Family 
Services Stage, including person demographics, person identifiers, address and phone 
information for all persons already associated with the stage. The following options are also 
available from this tab: 

• Retrieve the Historical Stage Composition 

• Change the Final Adoptive Name (FSS/CCR stages only) 

• Select Primary/Secondary Caretakers 

• Maintain Multiple Primary Address/Phone information 

• End Date stage involvement of persons in the stage 
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Revising Search Criteria 
Depending on the results of your search you may need to 
revise some of your information.  

 
If your search returns one or 

more prospective matches, you 
need to determine which, if any, 
of the matches is the person for 
whom you are searching. Here 

are some tips for doing this: 
• Review the information on 

the Person Search List. Use 
the horizontal scroll bar to 
view information to the right 
of the screen. Given clear 
differences in Dates of Birth, 
Sex, Ethnicity, Address 
information or Social 
Security number, a potential 
match may be ruled out 
right away. 

• Review information on the 
individual’s family. To do 
this, highlight a name on the 
list, click on the Options 
menu and select Case 
List…. Highlight a case and 
click on the Comp button. 
The Case Composition 
window displays a list of the 
people associated with that 
case. 

• Add any additional information you did not include in the 
original search by filling in fields like Age, Date of Birth 
(DOB), Sex, etc. 

• Click on the Search button to perform the new search. 
CONNECTIONS performs a new search based on your 
revised criteria and returns the results of your search in 
a list at the bottom of the Person Search window. 

• Review the search results to determine if any match is 
the person you are searching for.  
You may need to revise the search, depending upon 
your results. 

Viewing Detailed Information 
Detailed person information can also be accessed from the 
Case Summary window. Taking this route enables 
CONNECTIONS to verify that you have proper security rights to 
access detailed information on this case. If you do not have 
rights to view this information, buttons and options are disabled. 

From the Person Search window (containing the results of your 
search), you can view detailed information about the person by 
following the steps below: 

 

Step-by-Step: 
Viewing Detailed Information About a 
Person 

1 On the Person Search window, select a person’s name from the Person Search List. 
2 Click on the Case List… button. 

The Case List displays a list of cases with which the individual is associated. 
3 Click on a case to select it from the list. 
4 Click on the COMP button.  

The Case Composition list displays demographic information on the persons in the 
case, including Date of Birth and Ethnicity, Race, Address, Phone and Person ID. 

5 Click on a stage to select it from the Case Summary window. 
6 Click on the Options menu and select the Person List… command. 

The Person List displays. 
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7 Click on a person’s name to select it from the list. 
8 Click on the Options menu and select an enabled command. 
9 When you are done reviewing information about the person, close each window by 

clicking on either the Close or Cancel button. 

Maintaining Address and Phone Information 
There are four locations where you can maintain address and/or phone information for an 
individual: 

• The Person Detail window 
• The Maintain Primary Address and Phone window 
• The Address window 
• The Phone window 

If a person is being related or added to a stage, but that individual does not reside in the 
household (e.g., a biological parent who does not live with the child), it is usually more efficient 
to maintain the address and/or phone information for this individual in the Person Detail window. 

The Person Detail Window 
The Person Detail window enables you to modify information for an individual. Within this 
window you are able to maintain the following information: sex, ethnicity, marital status, primary 
language, date of birth (DOB), age, role, relationship/interest code, date of death (DOD) and 
reason for death. 

The Maintain Address Window 
The Maintain Address window enables you to view and record 
multiple addresses for an individual. Address records are 
distinguished by type, such as residence, business and mailing. 
Each address also includes a start date and (if applicable) end 
dates, allowing you to view both current and historical address 
information. In addition, an address record can be designated 
as “Primary” or as “Invalid.” A primary address is the address 
where the person physically lives and/or is most often found; an 
invalid address is an address that was never correct. Only one 
valid Primary address can exist for a person at one time. When 
you add a new Primary address for a person; the old Primary address end-dates automatically. 

 

Addresses should be invalidated 
only if they were never correct. 

Addresses that were correct but 
have changed are end-dated. 
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In order to maintain address information, the following must be true: 

• The Family Services Stage is open. 
—AND— 

• You have a role in the stage (or can access the Assigned Workload of a worker who 
has a role in the stage). 

This window is arranged in two main sections: the detail section at the top of the window and 
the list section at the bottom of the window. The detail section contains the following fields: 

Street 
PO Box/Apt 
City 
State 
ZIP 

 

These fields are used to record the address information. Information 
is entered directly in the fields. The State field is used to select the 
appropriate state from a drop-down list. 

CD  In this field the system-generated Community District (CD) code 
displays only for New York City addresses. This field cannot be 
modified. 

County  This field is used to select the appropriate County from a drop-down 
list. If you selected any state other than New York in the State field, 
“OUT OF STATE” must be selected in the County field.  

Type  This field is used to indicate whether the address is a residential 
address or another type of address (e.g., a business address). 

Primary  This check box is used to indicate that the associated address is the 
primary address. The primary address is the location where the 
individual resides. 
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Invalid  This check box is used to indicate that the associated address was 
never correct. If the address was previously (but is no longer) 
correct, the address should be end-dated not marked it as “Invalid.” 

 
The Type field is required for every address. Once an address has been recorded and saved, 
the type cannot be changed. For example, if you recorded and saved the person’s home 
address, inadvertently selecting Business in the Type field’s drop-down list, you must invalidate 
that address and record the address again (with the appropriate address type) in the detail 
section. 

The Start Date is the date on which the address was first 
recorded in the system. The End Date is the date on 
which the address is no longer applicable. When you 
invalidate an address, the End Date reflects the date 
when you invalidated the address; when you change the 
primary address, the End Date displays for the former 
primary address, indicating the date when the primary 
address change was recorded in CONNECTIONS. The 
Start Date and End Date fields are not modifiable; the 
Start Date is recorded automatically when you add an address, while the End Date field is 
recorded automatically when you record a new primary address or, for previously saved non-
primary addresses, when you click on the Set End Date button. 

 
When recording an out of state 

address in CONNECTIONS be sure 
to select “OUT OF STATE” in the 
County field drop-down menu.  

The Maintain Phone Window 
The Maintain Phone window enables you to view and 
record multiple phone numbers for an individual. Phone 
records are distinguished by type, such as residence, 
business and cellular. Each phone record also includes a 
start date and, if applicable, an end date, allowing you to 
view both current and historical phone information. In 
addition, a phone record can be designated as “Primary” 
or as “Invalid.” A primary phone record is the phone 
number where the person can most often be contacted; 
an invalid phone record is a phone number that was 
never correct. Only one valid Primary phone record can exist for a person at one time. When 
you add a new Primary phone record for a person; the old Primary phone record end-dates 
automatically. 

 

Phone numbers should be invalidated 
only if they were never correct. 

Phone numbers that were correct but 
have changed are end-dated. 
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The Maintain Primary Address and Phone Window 

 

Where am I? 

Assigned Workload > FSS 
>Tasks button > Options > 

Maintain Primary 
Address/Phone 

During the course of a CPS investigation or a services case, a 
family may move to a new address or may change its phone 
number. In order to maintain an accurate case record, you 
need to update this information in CONNECTIONS. Use the 
Maintain Primary Address and Phone window to accomplish 
this task. 

Unlike the Maintain Address or Maintain Phone windows, the 
Maintain Primary Address and Phone window enables you to 
apply an address or phone number to multiple individuals 
without having to retype information. 
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The Maintain Primary Address and Phone window is organized into two main sections: 
• The detail section in the upper half of the window (comprised of the Primary Address 

Information and Primary Phone Information sections) 
• The person grid in the lower half of the window 

The fields included in the Primary Address Information and Primary Phone Information sections 
are the same as those listed for the Maintain Address and Maintain Phone windows, 
respectively. The Person grid lists the individuals involved in the FSS stage and their respective 
address and phone information. 

If a person who lives in the household is being related or added to a stage, the Maintain Primary 
Address and Phone window enables you to maintain this information efficiently, while reducing 
the likelihood of data entry error. The Maintain Primary Address and Phone window also 
provides an efficient method for updating this information for several individuals in a household 
(e.g., when the family moves to a new address). 

 

Adding or Relating a Person in a Stage 
The process of conducting a thorough Person Search helps 
you avoid creating duplicate person records. This affects not 
only system data integrity but, more importantly, the accuracy, 
currency and completeness of a person’s historical record in 
the system. It is imperative that you have as much complete, 
accurate and current information as possible when making 
decisions that affect children and families. The CONNECTIONS 
system is dependent on the accuracy of case data in order to 
present accurate information about the family. 
 
If, after conducting a thorough Person Search, you determine that an individual is not known to 
the CONNECTIONS database and you need to add that person; the Add/Relate functionality 
allows you to add the individual to CONNECTIONS and establish a unique, system-generated 
Person ID for that individual. If you determine that the person is already known to 
CONNECTIONS, you need to relate that individual’s existing person record.  

 

Refer to Appendix B: Match 
Criteria Guidelines at the end of 
this guide for more information 
on deciding whether or not you 

can relate a person.  

 

Where am I? 

Assigned Workload >  
FSS >Tasks > Add/Relate 

button 

The Add/Relate Person Window 
The Add/Relate Person window displays for an FSS, CPS or 
FAD stage and is divided into three sections: 

• Search fields 
• Person Search List 
• Buttons 

Page 48 CONNECTIONS Step-by-Step Guide: 
v2.0 (rev 02/28/2007)   Common Functions 



 

 

The search fields provide a variety of informational categories for conducting and refining a 
Person Search. The following search fields are available: 

Search Type This field is used to select the type 
of search a worker would like to 
conduct from a drop-down list. A 
Person Search for individuals in 
CONNECTIONS may be 
conducted using different Search 
Types: 

• Phonetic Name 
• Phonetic Address 
• Exact 

The Search Type defaults to 
“Phonetic Name.” 
A Phonetic Name Person Search 

 
Required fields on the Person 

Search window highlight in 
yellow when the associated 
Search Type is selected. 

Fields that are not available 
for a particular Search Type 

disable when that type is 
selected. 

 returns matches that sound similar to the search criteria; this 
usually produces the largest pool of results. Phonetic Name 
search may be used even if the name you are searching for 
may not be spelled correctly. 

Phonetic Address Person Search returns results that sound 
similar to the information entered in the Address section. 

An Exact Person Search returns results that match the search 
criteria character for character and space for space. This type of 
search is typically used with Person ID numbers or Client 
Identification Numbers (CINs). 
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First, Middle, Last 
name 
Address Information 
DOB 
Age 
Race 
Sex 
Phone 
Identifiers section 

 

One or more of these fields may be used (when enabled; see 
the tip box on page 4-46) to enter search criteria. Using broader 
search criteria increases the likelihood of finding a potential 
match in CONNECTIONS. 

Detailed information about these fields or the detailed Person 
Search process can be found in the Search Techniques Step-
by-Step Guide, which is available on the OCFS 
CONNECTIONS intranet site. 

Appendix B of this guide, Match Criteria Guidelines includes  
more information on the criteria for relating a person. 

 
The Person Search List displays the results of the search. Some of the columns in the Person 
Search List match the search fields in the upper half of the window. Not all of the fields in the 
search section are included as columns in the Person Search List. Names that have been 
marked as “Invalid” will not return in a Person Search. 

The Person Search List also includes the following columns, which are not included in the 
search fields: 

Match Name This is the name of an individual who is recorded in 
CONNECTIONS. The Match Name can be a Primary name or 
an end-dated name. 

Primary Name This is the Primary name of an individual who is recorded in 
CONNECTIONS. Only names that have been recorded as 
“Primary” display in this column. 

Match This column denotes the type of Person Search that was 
conducted (and for which search results display): 

• Phonetic Name Person Search: “NAME” 
• Phonetic Address Person Search: “ADDR” 
• Exact Person Search: “EXCT” 

Score This column indicates the relative accuracy of a particular 
search result (compared to the search criteria) on a scale 
of 0 to 100. The Score for an Exact Person Search will always 
be “100.” 

The following buttons display at the bottom of the Add/Relate Person window: 

Search This button activates the search, based on the search criteria. 
The button enables only when you have entered the minimally 
required search criteria (based on the Search Type you 
selected). 

Case List This button opens the Case List, displaying all current and 
historical cases with which the selected person has been 
associated. 
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Relate This button opens the Add Person window, displaying person 
information currently recorded for the individual in 
CONNECTIONS. 

New This button opens the Add Person window, where you record 
complete demographic information about the person you are 
adding to the FSS, CPS, or FAD stage.  

Clear This button clears the search criteria fields, enabling you to 
enter new search criteria. 

Cancel This button closes the Add/Relate Person window. 

 

 

Step-by-Step: 
Conducting a Person Search to Add or Relate a Person 

1 On the Stage Composition tab on the Family 
Services Stage window, click on the Add/Relate 
button. 
The Add/Relate Person window displays. 

2 In the First and Last name fields on the Add/Relate 
Person window, enter the name of the person for 
whom you are searching. 

3 Click on the Search button. 
The search results display in the Person Search List 
at the bottom of the Add/Relate Person window. If 
no matches are found, the following message 
displays in the Person Search List title bar:  
“No Results Returned.” 

 

Step-by-Step: 
Conducting a Person Search to Add or Relate a Person in FAD or CPS 

 
Person Search defaults to the 
Phonetic Name Search Type. 
This usually produces the best 

pool of results. 

To conduct a Phonetic Address 
or Exact search, click on the 

drop-down arrow for the Search 
Type field and select from the 

resulting list. 

Refer to Appendix B: Match 
Criteria Guidelines for more 

information 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select an INV or FAD stage on the Assigned Workload. 
The Tasks…button enables. 

3 Click on the Tasks…button. 
The Task List displays. 

4 Select Maintain Person from the list. 
The List…button enables. 

5 Click on the List…button.  
The Person List displays. 
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6 Click on the New…button. 
The Person Search window displays. 

7 In the First and Last name fields on the Person Search window, enter the name of 
the person for whom you are searching. 

8 Click on the Search button. 
The search results display in the Person Search list at the bottom of the Person 
Search window. If no matches are found, the following message displays in the 
Person Search List title bar: “No Results Returned.” 

Staff Search from the CONNECTIONS Toolbar 
Person Search is also helpful for finding staff persons when you do not know their agency code. 
By conducting a Person Search in this situation, you can obtain the Person ID for a staff person, 
and then use the Person ID to conduct a Staff Search. You cannot obtain detailed information 
about a staff person in Person Search; use the staff person’s Person ID to conduct a Staff 
Search in order to retrieve detailed information. 

 

Step by Step: 
Conducting a Staff Search from the CONNECTIONS Toolbar 

1 Click on the STAFF button on the CONNECTIONS 
Toolbar. 
The Staff Search Criteria window displays. The 
Agency field is pre-filled and the Active check box 
is selected.  

If you are unsure how to spell 
the staff member’s name, enter 

only the portion of the name 
that you know. 

 
When you click on a staff 

member’s name in the Person 
Search List, the following 

message displays: 

“This person is an Employee. 
For more information use Staff 

Search.” 

This message helps you identify 
employees in the listing. 

2 Enter search criteria: either the Person ID number or 
the person’s last name. (Just a portion of the last 
name is enough, unless you are searching for a 
common name in a large agency.) 

3 If you are searching for a worker outside your 
agency and you know that person’s agency code, 
type it in the Agency field and skip to step 
#8 (the Agency field defaults to your own agency 
code). 

4 If you don’t know a worker’s agency code, click on 
the PERS button on the CONNECTIONS Toolbar 
and complete a Person Search. 

5 When you have completed the Person Search, write 
down the individual’s Person ID number from the 
Person Search List. 

6 Click on the Cancel button to close the Person 
Search window. 
The Staff Search Criteria window displays. 
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7 Type the worker’s Person ID number in the Person ID field. 

8 Click on the Search button on the Staff Search Criteria window. 
The Staff List displays with the results of your search. 

9 Click on a name to select it from the Staff List. 

10 Click on the Detail… button. 
The Staff Detail window displays. 

11 To close the Staff Detail window, click on the Cancel button. 
The Staff List displays. 

12 To close the Staff List, click on the Close button. 
The Staff Search Criteria window displays. 

13 To close the Staff Search Criteria window, click on the Close button. 
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Progress Notes 

Security Information  
There are some security considerations to keep in mind when you are recording progress notes. 
Some of you may be authorized to complete your job functions outside of the office (e.g., using 
a laptop computer, cellular phone or handheld devices). When working from a remote location, 
the following security controls that must be considered include (but are not limited to): 

• the existing physical security of the remote location; 

• the communication security requirements; 

• the sensitivity of the information that will be accessed and transmitted; and 

• the threat of unauthorized access. 

Progress Notes exist in the CPS investigation stage and the FSS stage. For the CPS 
investigation stage and the FSS stage, except the FSS/ADVPO stage type, caseworkers are 
required to document and maintain all progress notes and casework contacts on all relevant 
case activities in which the worker is directly involved, or that directly impact the aspect of the 
case for which the worker is responsible (For more information, refer to Appendix C: Progress 
Notes Guidelines located at the end of this guide). 

Your ability to access, view and maintain progress notes is dependent on a number of factors. 
There are three distinct security rights that workers need in order to work with progress notes in 
CONNECTIONS. Your role in the stage and your need to complete certain tasks dictates the 
rights that you are assigned to. 

In order to create notes, you must be: 

• assigned a role in the stage;  

• within the assigned worker’s unit hierarchy;  

• assigned the ENTER PROG NOTE Business Function; or 

• assigned a Progress Notes Task To-Do. 
 

In order to modify notes, you must be: 

• the progress note’s Author; or 

• the progress note’s Entered By person. 

 

If the author has been identified as “Other,” then only the Entered By person can modify a note. 

Page 54 CONNECTIONS Step-by-Step Guide: 
v2.0 (rev 02/28/2007)   Common Functions 



 

Recording Progress Notes 
When assigned to an FSS stage or CPS investigation you must record progress notes in a 
timely manner. When recording progress notes, you are providing documentation of all the 
activities associated with the provision of child welfare services in an objective and behaviorally 
specific way. Your progress notes should document the timely activities of casework staff and 
the information acquired during these activities. Progress notes should support your conclusions 
about safety, risk, family functioning, and the credible evidence that exists (or fails to exist) to 
substantiate allegations of child abuse and maltreatment. Additional casework activity that 
supports decision-making and service and permanency planning is to be documented in 
progress notes for cases that are opened for services, as well as for cases in which children 
have been placed in out-of-home care.  Progress notes should be recorded contemporaneously 
with the event, interview, observation or activity to preserve the integrity of the information being 
recorded.  

These activities serve several important functions: 
• Recording information related to the child(ren)’s safety serves to document the 

caseworker’s assessment of whether a child is safe in the home; this includes any 
identified safety factors, as well as family strengths and/or family, neighborhood or 
community resources that mitigate or address safety concerns. If it is determined that 
the child is not safe in the home after considering the safety factors, strengths and 
mitigating circumstances, caseworkers document the interventions initiated to protect the 
child(ren). 

• Recording the casework activities that have been completed and the dates of services 
that have been provided enables the caseworker to document compliance with legal 
requirements pertaining to a specific case. 

Information that is relevant to the child or parent’s safety, well-being and permanency should be 
recorded in progress notes and available to others as it may impact the direction of the overall 
effort. 

The Progress Notes functionality in CONNECTIONS enables you to: 
• create and modify progress notes; 
• use the Search, Sort and View functions with progress 

notes; 

 
Refer to Appendix C: Progress 

Notes Guidelines for more 
detailed information regarding 

Progress Notes. 

• add an Addendum to a “frozen” note; 
• copy progress notes from one stage to another in the 

same case (however, workers cannot copy notes from 
a CPS Investigation stage to an FSS stage) 

• use the Copy and Paste functions; and 

• copy notes from an FSS stage to a CPS stage. 
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The Progress Notes Tab 
The Progress Notes functionality has two main components: The Progress Notes Detail window, 
which is used to record and modify individual progress notes, and the Progress Notes tab which 
opens a window to search for notes, as well as to sort and filter search results. 

 
The Progress Notes tab is comprised of three sections: the Search Progress Notes filter fields 
at the header, the search results grid in the middle, and buttons along the footer. 

The fields at the top of the window are the search filters that can be selected. These filters 
comprise the bulk of the columns of the search results grid located in the middle of the tab. 

From Event Date 
and 
To Event Date 

This field is used to filter the Progress Notes that display based 
on the range of dates you select in the search criteria. To search 
for one specific event date, enter the same date in both fields. To 
search on an open-ended date, enter the date in the From Event 
Date field and leave the To Event Date field blank. All progress 
notes from that date forward will return in the search. Conversely, 
the same procedure can be performed with the To Event Date; 
all of the notes from that date back will return in the search. 

Type This field is used to filter the search results by type of contact as 
selected from the Type window. 

Author This field is use to filter the search results by the author of the 
note. The author may be selected from a drop-down list 
populated with the name(s) of anyone who has already authored 
a note in the stage. 
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Family Part. 
(participant) 

This field is used to filter the search results by family participant 
selected from the drop-down list consisting of all persons in the 
stage. 

Method This field is used to filter the results by the Method of Contact 
from a drop-down list containing possible methods.  

Entered By This field is used to filter the search list by Entered By person; 
the drop-down list is comprised of the workers who have 
recorded notes. 

Other Part. 
(participant) 

This field is used to filter the search (by category, not name) by 
others outside the Person List for the case who may be 
participants or contacts involved in the case. The Other 
Participant’s category, not name, may be selected from a drop-
down list.  

Purpose This field is used to filter the results by the Purpose of the 
contact. 

District/Agency This field is used to filter the search results by the code of the 
District/Agency of the Entered By worker. 

Focus This field is used to filter the results by the person who is the 
focus of the note. You select from a drop-down list comprised of 
possible focuses. 

Location This field is used to filter the results by the Location of the contact

The search results grid displays many of the fields listed above, 
as well as fields on the Progress Notes Detail window. (Many 
of these fields are listed on both the Progress Notes tab and 
the Progress Notes Detail window). There are three filters that 
do not display on either the Progress Notes Detail window or 
the Progress Notes tab in the search filters, but they do 
display in the search results grid: 

• Note Status indicates whether the note is in “Final” or 
“Draft” status. 

• Addendum indicates whether or not an addendum has 
been added to the note.  

• Copied From indicates the stage from which the note 
was copied. This never prints on any of the Progress 
Notes Data Reports.  

Several buttons display on the Progress Notes tab: 

Refr
esh 
List conducted, this button enables. 

Sear
ch 

 
ting search criteria. 

This button refreshes the grid to the default display list of 
notes and removes all search criteria. Once a search has 
been 

This button is used to initiate a Progress Notes search after
selec

 
If necessary the scroll bar may 

be used to see all of the 
columns on the search results 

grid. 

 
In addition, the following 

functionality is available from 
the Options menu: 

  Add Addendum 

  Create To-Do 
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View Note This button is used to view the details of a specific note. 

New Note This button opens a blank Progress Notes Detail window. 

Edit Note This button is used to open the Progress Notes Detail window and 
modify the selected note. Only notes in “Draft” status can be edited. 

Copy Note This button is used to copy a note that has been selected from the 
search results. Clicking on this button opens the Copy Note button to 
copy a saved note between stages of the same case. 

Select All This button is used to select all of the progress notes in the grid to print 
at once. 

Searching for Progress Notes 
Workers and supervisors may find it useful to search for notes (e.g., you may want to view notes 
that have already been recorded in CONNECTIONS to review what has occurred throughout 
course of the investigation; your supervisor may want to view previously recorded notes when 
approving work). You conduct a progress notes search on the Progress Notes tab.  

There are two ways to begin a search: 

• Access the Progress Notes tab in view-only mode through the CPRS event on the 
Event List. 

• Select the Child Protective Record Summary task from the Task List, then click on the 
Progress Notes tab. 

By default, when you access the Progress Notes tab, the search results grid displays all of the 
progress notes for the stage. The most recent notes display at the bottom of the list. 

You may want to view notes that contain certain criteria. For example, you may want to display 
only the notes in which a particular family member is the focus. Use a progress notes search to 
display only those notes with the focus on that family member. Searching retrieves a list of 
existing progress notes for a stage. 

Once you have selected a note, the View Note, Copy Note and Print Note(s) buttons enable. If 
the note you selected is in Draft status, the Edit Note button also enables. The Search button 
enables once the search criteria is selected. 



 

 

 

Step-by-Step: 
Searching for Progress Notes 

1 Click on the Progress Notes tab in the CPRS. 
The Progress Notes tab displays with a list of 
notes that have been saved for that stage.  

Click on the Refresh List button 
to remove the sorts and/or 

search criteria that have been 
selected. 

2 Enter search criteria in the data fields in the upper 
half of the window. 
Multiple fields can be used to search for notes; 
however, keep in mind that the more search criteria 
you enter, the more limited your search will be. 

3 Click on the Search button. 
The search results display with all notes that match the search criteria. 
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The Progress Notes Detail Window 

 
The creation of a new note is completed via the Progress Notes Detail window. Modifying, 
duplicating, saving and printing progress notes can also be completed on this window. The 
window is separated into two main parts: 

• The data fields are used to record contact-specific data, such as who was contacted, 
and when and where the contact was made. Some data fields are system-populated, 
others are required, and still others are optional. 

• The narrative field is used to record clear, descriptive and factual information about 
the events, conversations and resolutions that took place during the contact. Your 
impressions or opinions, and relevant information to support these, can also be 
expressed and should be labeled as such, as well as the participation and 
perceptions of family members in the planning for services. The narrative has a text 
tool control feature, which enables you to use certain Microsoft Word-like formatting 
and functionality. 
 

 

Step-by-Step: 
Opening the Progress Notes Detail Window 

1 On the Progress Notes window, click on the New Note button to open the Progress 
Notes Detail window to create a new note. 
—OR— 
Click on an existing “Draft” note from the list, then click on the Edit Note button to 
open the Progress Notes Detail window to view or modify an existing note. (If you 
select a “Final” note from the list, it can only be viewed, not modified.) 
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The following fields display on the Progress Notes Detail window: 

Event Date This field identifies the date the contact took place; this is a 
required field for any note (expect those with a Type of 
“Summary”). Click on the checkbox to populate this field with a 
check mark. The Event Date field defaults to today’s date. If you’d 
like to change that date to a date in the past, click on the drop-
down arrow and select a date from the calendar. 

Type This field indicates the type of 
contact made. This is a required 
field. You can select one or more 
Type(s) for a note, but you must 
select at least one type. If you 
select more than one, “multiple” 
displays in the field 

  

Contacts here refer to any 
contact related to casework 

activity such as collaterals and 
court. 

Method of Contact This field indicates how or by what means the contact was made 
(e.g., Face to Face, Phone). This field is required and contains a 
drop-down list with options. Methods are available based on the 
Type of contact you select. 

Time The time the contact occurred in hours and minutes (with AM and 
PM [e.g., 1:00 PM], or military time [e.g., 13:00]). 

Unannounced Visit 
(checkbox) 

This field indicates that contact was made without a prearranged 
appointment. This checkbox is enabled only when the Type of 
contact is “Attempted Casework Contact” or “Casework Contact.” 

Location of Contact This field identifies where the contact took place. The location is 
selected from a drop-down list. There are times when this field is 
required, enabled or disabled, depending on the responses you 
select in other fields.  

Family 
Participant/Focus 

This field contains the list of persons identified on the Person List 
who are part of any concurrently open stages. It is system-
populated and cannot be modified. Two checkboxes within this 
field can be selected: 

• The Family Participant (FP) checkbox allows you to indicate 
which family participant(s) were present at the contact. There 
are times when this checkbox is required, enabled or disabled, 
depending on the responses you select in other fields.  

• The Focus checkbox allows you to indicate which individual(s) 
from the Person List is the focus of a particular contact. There 
are times when this checkbox is required, enabled or disabled 
depending on the responses you select in other fields.  

Family Participants are any family members who are present at 
the contact (e.g., a phone call from the biological father or a family 
visitation with the mother); the Focus refers to the individual(s) 
about whom the contact occurred. For example, if you, the teacher 

CONNECTIONS Step-by-Step Guide: Page 61 
Common Functions v2.0 (rev 02/28/2007) 



 

and the mother met to discuss the child’s Individual Education Plan 
(IEP), the mother would be the Family Participant and the child 
would be the Focus (even though he was not present), because 
the purpose of the meeting was to discuss his IEP. The teacher 
would be included as an Other Participant. 
This field also features the All button, which applies only to the 
Family Participant field. It enables a worker to select all of the 
individuals in the family for that note’s contact. This can be a time-
saver, since the worker does not need to select each person 
individually. If, for example, all family members except one or two 
were present for the contact, a worker can click on the All button to 
select everyone in the family, then click on the corresponding 
checkbox(es) to deselect the few individuals who were not present. 

You cannot save a progress note without selecting a Family 
Participant (or Other Participant) when one is required; the Save 
as Draft and Save as Final buttons do not enable until a Family 
Participant or Other Participant is selected.  

Other Participant This field contains a list (by category, not name) of others outside 
the Person List for the case who may be participants or contacts 
involved in the case. You can select one or more participants on 
the Other Participant window for each note. If you select more than 
one, “multiple” displays in the field. There are certain situations 
when this field is required, enabled or disabled. 

Author This required field indicates the person who made the contact or 
directly acquired the information being written about. The list of 
choices will be comprised of the assigned worker(s) in the 
district/agency, anyone assigned in or out in that unit, and “Other.” 
When the Entered By worker is an assigned worker, the Author 
field will default to the name of that worker. You can select a 
different Author, if necessary. 

Entered By This field contains the system-populated name (based on Person 
ID) of the worker recording the note in CONNECTIONS. 

Dist./Agy This system-populated field indicates the code of the 
District/Agency of the worker in the Entered By field.  

Entry Date This field reflects the date the window is first accessed. This date is 
system-filled and cannot be modified. 
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Purpose This field indicates the purpose of, or reason for, the contact. More 
than one Purpose may be selected for a note. If you select more 
than one, “multiple” displays in the field. 
 

 
To see a list of conditionally required 
purposes refer to Appendix C of the 

Case Management Step by Step 
Guide or place your cursor in the 

Purpose field of the Progress Notes 
tab and select the F1 key on the 

keyboard.  

Progress Notes 
Narrative 

In this required field, the Author or Entered By person documents 
all of the details pertaining to the note. 

The following buttons display at the bottom of the Progress Notes Detail window: 

Copy Note Clicking on this button initiates the action of copying a saved note. 
This button is disabled when you open the Progress Notes Detail 
window in modify mode and make changes. The button enables 
when: 

• a note is selected on the Progress Notes tab or displayed 
in the Progress Notes Detail window; and 

• the open “copied to” Investigation stage has the same Case 
ID as the “copied from” Investigation stage. 
 

New Note Clicking on this button clears the existing fields to allow you to 
create a new note without needing to close the Progress Notes 
Detail window. 

This button is disabled on the Progress Notes Detail window, 
except when viewing an existing note. 

View Existing Notes This button enables when you open the Progress Notes Detail 
window but you have not made any changes to a note. Once you 
make changes, this button disables. Clicking on this button 
displays the Progress Notes tab; you can then select a note to 
view. 

Save as Draft This button enables when you create a new note and record all 
required fields, or when you modify data within an exiting “Draft” 
note and all of the required fields are populated. Clicking on this 
button saves the note in draft status. Notes are in draft status for a 
maximum of 15 calendar days (See “Saving Progress Notes” in 
this guide). 
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Save as Final This button enables when you create a new note and record all of 
the required fields, or when you modify data within an existing  

“Draft” note and all of the required 
fields are populated. Clicking on this 
button saves the note as “Final,” 
which “freezes” the note. None of the 
entries can be modified; however, 
addenda can be added.  

 

If the Cancel button is 
disabled, use the View 

Existing Notes button to 
return to the Progress 

Notes tab. 

Two arrow buttons ( ) display at the bottom of the Progress Notes window. When more 
than 200 progress notes entries are recorded on the window, a new “page” is created; each 
page holds a maximum of 200 entries. These buttons are used to scroll between pages of 
progress notes and enable when more than one page of notes exists.  
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Several fields on the Progress Notes window and Progress Notes Detail window contain the 
following drop-down lists that are common across all stages: 

• Type 

 
All CPS staff must 

record any identifying 
information related to 

contacts with the 
reporter/source in 

Investigation stage 
progress notes only, 

selecting 
Reporter/Source in the 
Other Participant field 
on the Progress Notes 

Detail window. 

Information identifying 
the reporter/source, 

including the agency, 
institution, organization, 

and/or program with 
which such person(s) is 
associated should not 
be documented in any 

other part of the 
Investigation stage, 

including Safety 
Assessments, the Risk 

Assessment Profile, 
Investigative Actions, or 
Investigative Findings. 

• Other Participant  
• Location 
• Method 
• Purpose 

Some choices are available on the Progress Notes Detail 
window only under specific circumstances: 

• Review Note and Review Case are only available as 
choices when the Type is “Supervisor/Managerial 
Review” for all stage types. 

• 24 Hour is available as a choice for Purpose when the 
Type is “Casework Contact” or “Attempted Casework 
Contact” only for Investigation (INV) stages. 

• Reporter/Source is available as a choice for Other 
Participant only for CPS Investigation stages. It is not 
available for Family Services Stages. 

The Type, Method of Contact and Author fields are required 
for all notes. Based on the selections made for Type and 
Method of Contact:  

• some fields are required; 

• some fields are enabled or disabled; and 

• some of the choices in the drop-down lists may change. 
 

 

 

Step-by-Step: 
Creating a Progress Note 

1 Click on the New Note button to open the Progress Notes Detail window. 
The Author field pre-populates with the name of the worker logged on to 
CONNECTIONS. To change this information, click on the drop-down list for the Author 
field and select a different author from the resulting list. 

2 In the Event Date field, click on the checkbox for the current date to accept that date. 
To select a different date, click on the drop-down arrow and select from the resulting 
calendar. 

3 In the Type field, click on the ellipsis (…) button. 
The Type window displays. 

4 Select one or more types by clicking on the checkbox(es). 
The OK button enables 
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5 Click on the OK button. 
The Progress Notes Detail window displays with the 
Method of Contact field highlighted in yellow. 

6 Click on the drop-down arrow for the Method of 
Contact field and select from the resulting list. 

7 Put a check in the Unannounced Visit checkbox, if 
applicable. 
This field only displays when the Type is Casework 
Contact or Attempted Casework Contact. 

8 In the Time field, enter the time of the contact. 

9 Click on the drop-down arrow for the Location of 
Contact field and select from the resulting list. 
This field may or may not be enabled, depending on 
the Type and/or Method of contact. 

10 In the Family Participant/Focus field, select the 
appropriate individuals as the family participant(s) 
and/or focus(es) of the contact by clicking on the 
respective checkboxes. (See page 61.) 
This field may or may not be enabled, depending on 
the Type and/or Method of Contact. 

11 In the Other Participant field, click on the ellipsis (...) 
button and select one or more other participants by 
clicking on the checkbox(es). 
The Other Participant field contains a list of individuals that are not on the Person List 
who may be participants or contacts involved in the 
stage.  

 
If you later change the 

information recorded in the 
Type field, the following 

message displays: 

“Changing TYPE will clear all 
user entered data fields except 

the Narrative. 
Continue making changes?” 

Click on the Yes button to 
discard the data. 

Click on the No button to 
cancel the action without 
clearing the data fields. 

In both cases, the Progress 
Notes Detail window remains 
open. If the Type is changed, 

fields that were cleared by 
CONNECTIONS will need to be 

re-recorded. 

 
To allow for modifications to a 
note during the draft period, 

save the note as “Draft.” If no 
modifications are necessary, 

save the note as “Final.”  

Remember that once a note is 
saved as “Final,” no 

modifications can be made; only 
addenda can be appended to 

the note. 

12 Click on the OK button. 

13 In the Purpose field, click on the ellipsis (...) button. 
The Purpose window displays. 

14 Select one or more purposes by clicking on the 
checkbox(es).  
The OK button enables. 

15 Click on the OK button. 
The Progress Notes Detail window displays. 

16 Record the narrative of the progress note in the 
Narrative field. 

17 Click on the Save as Draft or Save as Final button. 
(See the tip box at right.) 
The following message displays: 
“Changes Have Been Saved.” 

18 Click on the OK button. 
The Progress Notes tab displays. 
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Saving Progress Notes 
There are two ways to save a note: as “Draft” and as “Final.” 

 
While creating a note, if you 
attempt to modify an existing 

value for Method of Contact, the 
following message displays: 

“Changing METHOD may clear 
the user entered data fields that 

are inconsistent with the new 
METHOD. Continue making 

changes?” 

Clicking on the Yes button 
clears all recorded data fields on 

the Progress Notes Detail 
window that are inconsistent 

with the new Method of Contact 
(except for the narrative). 

Clicking on the No button 
cancels the actions without 

clearing any of the data fields. 

In both situations, you remain 
on the Progress Notes Detail 
window. If you changed the 

Method of Contact, you need to 
re-record information in the 
fields that were created by 

CONNECTIONS. 

Save as Draft Notes can be saved in Draft status for up 
to 15 calendar days. Modifications can be 
made only during the Draft period. If you 
have not saved the note as “Final” by the 
end of the 15-calendar-day Draft period, 
the note automatically saves as “Final.” 
When you save a note in Draft status, the 
newly saved note displays in the search 
results list on the Progress Notes tab. 
The Note Status column populates with 
“Draft.”  

As part of the nightly batch update, 
CONNECTIONS identifies any notes that 
have been in “Draft” status for 15 calendar 
days and changes the status to “Final.” 
Each time a note is saved, 
CONNECTIONS keeps an historical 
record of when notes are saved and by 
whom. 

Save as Final Progress notes should be saved as 
“Final” as soon as possible. To save a 
note as “Final,” click on the Save as Final 
button. You can save a note as “Final” at 
any time during the 15-calendar-day 
Draft period. Notes in Draft status are 
automatically saved as “Final” at the end 
of the 15-calendar-day period. Once a 
note is in Final status, it displays in the 
search results list on the Progress Notes 
tab. The Note Status column populates 
with “Final.” A note saved as “Final” 
freezes; modifications can no longer be 
made to the note. Only an addendum 
can be appended to the end of the frozen 
note. When a stage is closed, 
CONNECTIONS converts any Draft 
notes to Final status.  

 
All progress notes must be 

saved as “Final” prior to 
providing them to any entity 

legally authorized to receive the 
record (e.g., family court, district 

attorney). Do not copy and 
paste tables, or insert scanned 
documents or photocopies of 
documents into a progress 

notes narrative, this may result 
in the inability to print the 

progress notes for the stage. 
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Viewing Progress Notes 
Multiple progress notes can be viewed conveniently by the use of the scrolling feature found on 
the Progress Notes Details window.  

 

Step-by-Step: 
Viewing Progress Notes 

1 On the Progress Notes window, select the note to be viewed. 
2 Click on the View Note button. 

The Progress Notes Detail window displays for the selected progress note. 
3 Click on the arrow keys located on the upper right of the 

displayed Progress Note to scroll between notes.    

Modifying Progress Notes 
Progress notes can only be modified while in “Draft” status. Once a note has been saved as 
“Final,” it can no longer be modified; only an addendum may be made. If the Type of contact is 
changed, CONNECTIONS clears all of the worker-recorded data, with the exception of the 
narrative. If the Method of Contact is modified, the system clears all data fields that are 
inconsistent with the newly selected method. 

 

Step-by-Step: 
Modifying a Progress Note 

1 On the Progress Notes window, click on the note in “Draft” status to be modified. 
2 Click on the Edit Note button. 

The Progress Notes Detail window displays for the selected progress note. 
3 Make the necessary modifications. Once all of the required fields are recorded, click 

on the Save as Draft button. 
—OR— 
Click on the Save as Final button. 
The following message displays: “Changes have been saved.” 

4 Click on the OK button. 
The Progress Notes window displays. 

Adding an Addendum to a Frozen Note 
To modify notes that are in “Final” status, addenda are 
necessary. Addenda can be added to notes in open stages. In 
addition, the Closed Stage Addendum function can be used to 
create a new note in a closed stage. (When recording a Closed 
Stage Addendum, the note must be saved as “Final.”) 

 
Since supervisors cannot modify 

their workers’ notes, they use 
addenda to add information to 
or clarify a note completed by 

one of their workers. 

Addenda can be added by the progress note’s Author, by 
anyone in the Author’s unit hierarchy and by the progress 
note’s Entered By person. When the Author of a progress note 
is identified as “Other,” a new addendum may be added by the 
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progress note’s Entered By person, the assigned worker and anyone in the Entered By person’s 
hierarchy. A person outside of the unit hierarchy cannot amend a progress note when the author 
is identified as “Other”; a new note must be created. 

Addenda are added to the bottom of the narrative of the original note. A progress note can have 
multiple addenda as long as the stage remains open. The new text is time-stamped with the 
name and ID of the logged-on worker. All previously recorded text in notes and addenda are 
locked for edit while a new addendum is being created. Once the narrative recording has been 
started, the View Existing Notes, Copy Note and New Note buttons disable, while the Save 
as Final and Cancel buttons enable. Addenda may only be saved as “Final.” 

 

Step-by-Step: 
Recording an Addendum to a Progress Note 

1 On the Progress Notes window, click on a note in “Final” status. 
2 Click on the Options menu and select Add Addendum. 

The Progress Notes Detail window displays for the selected progress note. All 
existing fields and the narrative are locked for edit. 

3 Record text at the bottom of the existing narrative. 
4 Click on the Save as Final button to save the 

addendum. 
The following message displays:  
“Changes have been saved.” 

 
If you click on the Cancel 

button, the addendum is not 
added, and the time/date and 
name are not stamped on the 

existing progress note. 

5 Click on the OK button. 
The Progress Notes window displays. Once an 
addendum has been added to a progress note, the 
Addendum column of the search grid is flagged 
with a “Y,” indicating an addendum exists for the 
note. For notes that do not have addenda, the 
column is flagged with an “N.” 

Printing Progress Notes 
The Progress Notes window provides the availability to view and print one, several or all 
progress notes in the stage. Notes print as one document, listed from oldest to newest; 
however, if you sorted the progress notes before printing, they will print in the order listed on the 
Progress Notes window. 

The Progress Notes Report displays only the fields for which information was recorded. For 
example, if information was recorded in the Time field but not in the Other Participant field, the 
Time field (and its corresponding entry) will display on the report, but the Other Participant 
field will not. 

 

Step-by-Step: 
Printing Progress Notes from the Progress Notes Window 

1 From the Progress Notes window, click on each note to be printed. 
To select multiple notes, hold down the Ctrl key as you select each note. 
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—OR— 
Click on the Select All button to select all notes. 

2 Click on the Print Note(s) button. 
—OR— 
Click on the File menu and select the 
Print command. 
The Print Notes window displays. 

3 Click on the corresponding radio button to 
print Data Fields and Narrative or 
Data Fields Only. 
Printing only the data fields generates the 
Progress Notes Data Report. 

4 Click on the OK button. 
The selected note displays in a separate window. 

5 Click on the Print button in the lower left corner of the window.  

 

 

 

Step-by-Step: 
Printing Progress Notes from the Progress Notes Detail Window 

1 From the Progress Notes Detail window, click 
on the Options menu and select the Print 
Note command. 
The Print Notes window displays. 

 
When printing more than 400 

Progress Notes, a delay in processing 
can occur. 

To alleviate this, enter a 30 day range 
in the Event Date areas and then 
click Select All prior to printing the 

Progress Notes.  Repeat the process 
in 30 day increments until all records 

have been printed. 

2 Click on the corresponding radio button to print 
Data Fields and Narrative or Data Fields 
Only. 

3 Click on the OK button. 
The selected note displays in a separate 
window. 

4 Click on the Print button in the lower left 
corner of the window.  

 

Completing Progress/Contact Notes in the FRS 
Contact notes may be recorded in the Contact Tab of the Foster and Adoptive Home Record 
Summary (FRS). Documenting casework contacts and activities in this tab keeps all information 
about a home/stage together in one record.  
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The Contacts tab is simply a listing of separate notes documented for casework contacts and 
activities. The following information is displayed (in columns) for each contact: 

• Date/Time Recorded  
• Contacted By  
• Purpose  
• Contact Date  
• Method  
• Location  

Three buttons display at the bottom of the tab. Use the Add New button to record new contact 
notes. The Contact Details button displays a selected contact note, and the Delete button will 
remove a selected contact. 

 

Step by Step: 
Creating and Saving Contact Notes in the FRS 

1 On the Assigned Workload, select the FAD home/stage you need to update and click 
on the Tasks… button. 
The Task List displays. 

2 Select the Home Study task. 
3 Click on the New, Detail or Use Prior button (Detail is enabled when there is an  

in-process FRS). 
The FRS displays. 

4 Click on the Contacts tab, and click on the Add New button. 
The Contacts window displays. 

5 Complete the following fields: Contact Date, Contacted By, Method, Participants, 
Location, Purpose and Comments. 

6 When you are finished, click on the Save button to store information in 
CONNECTIONS (click on the Cancel button to leave the window without saving 
information). 
The FRS displays with the Contacts tab active. 

7 Click on the OK button in response to the following message:  
“Changes have been saved.” 
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Creating Reports in CONNECTIONS 

Generating, Viewing and Printing Reports 
CONNECTIONS provides pre-designed reports and forms for printing information. 

In many areas in CONNECTIONS, creating, viewing and printing a report is a three-step 
process. First you generate the report from an associated window; you can either use the 
RPRTS button on the Toolbar to view it or by clicking on the Options field and selecting 
Reporting. Once the report is open, you will be able to print it. You can click on the Generate 
Report button and select the tabs to be printed. 

 

Step by Step: 
Generating a Report  

1 Open the window from which you can generate the 
desired report. 

 

A worker may first have 
to select an item (e.g. a 
stage from the Assigned 

Workload) before the 
Reports menu is 

enabled. 

2 Click on the Reports menu on that window and select the 
desired report command. 
The following message displays: 
“The Report has been launched. Check Report List.” 

3 Click on the OK button. 
 

 

Step by Step: 
Viewing a Generated Report  

1 Click on the RPRTS button on the CONNECTIONS Toolbar. 
The Report List displays. 

2 Click on the report you want to view. 

3 Make sure that the report’s status reads “DONE.” If it is still in “PEND” or “RUN” status, 
click on the Refresh button or close the window and return in a few minutes. You need 
to wait for the report to launch completely before you can view it. 

4 Click on the Open button. 
The report opens as a Microsoft Word document. 
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Step by Step: 
Printing a Generated Report  

1 Click on the File menu in the Word document window and select Print. 
The Microsoft Word Print dialog box displays. 
Verify that the prompted printer choice is correct and select the number of copies to 
be printed. 

2 Click on the OK button. 
The document is sent to the selected printer. 

3 To close the report, click on the File menu and select Close. 
The Report List displays. 

4 To close the Report List, click on the Close button. 

Reports 
CONNECTIONS utilizes a specific window, the Generate Report window, to organize the 
printing of information displayed in the Foster and Adoptive Home Record Summary (FRS) and 
the Child Protective Record Summary (CPRS). The Generate Report window lists the sections 
that can be printed, and includes an option for printing the entire 
summary. The Generate Report window is accessed via the 
Generate Report button, which is always visible at the bottom of 
the FRS or CPRS window. Clicking on this button generates the 
Generate Reports window. 

The first option displayed on the Generate Report window, is “All 
Tabs.”  Selecting this option and clicking on the OK button prints 
all information displayed on the tabs listed on the Generate 
Report window. 

Under the “All Tabs” option is a listing of each section that can be 
printed. One or more sections may be printed by clicking on the appropriate check boxes. 

 

Your agency Data Warehouse 
contact can help you obtain 

other reports, such as a listing 
of the foster homes for your 

agency and foster parent 
reports. 

You may choose one or more of these options to view and print. Click on the OK button to 
initiate printing, the reports open and print in Adobe Acrobat Reader.  

 

Step by Step: 
Accessing the Generate Report Window in the FRS 

1 On the Assigned Workload, select the appropriate FAD home/stage and click on the 
Tasks… button. 
The Task List displays. 

2 Select the appropriate task to access the FRS (either the Home Study, Annual 
Reauthorization, or View FAD Record Summary task), and click on the Detail button. 
The FRS displays. 
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3 Click on the Generate Report button at the bottom of the FRS window. 
The Generate Report window displays. 

4 Select the type of information you would like to print (e.g., All Tabs). 
5 Click on the OK button. 

Adobe Acrobat Reader opens, displaying the selected information in a formatted 
report. 

6 Click on the Print button in the lower left corner of the window. 
Your selection will print. 

7 Click on the Close button in the lower right corner of the document window, to return 
to the Generate Report window. 

8 Click on the Cancel button in the lower right corner of the Generate Report window, 
to return to the FRS. 

 

Step by Step: 
Accessing the Generate Report Window in the CPRS 

1 On the Assigned Workload, select the appropriate stage and click on the Tasks… 
button. 
The Task List displays. 

2 Select the Child Protective Record Summary task and click on the Detail button. 
The CPRS displays. 

3 Click on the Generate Report button at the bottom of the CPRS window. 
The Generate Report window displays. (Progress Notes must be printed from the 
Progress Notes tab of the CPRS). 

4 Select the type of information you would like to print (e.g., All Tabs). 
5 Click on the OK button. 

Adobe Acrobat Reader opens, displaying the selected information in a formatted 
report. 

6 Click on the Print button in the lower left corner of the window. 
Your selection will print. 

7 Click on the Close button in the lower right corner of the document window, to return 
to the Generate Report window. 

8 Click on the Cancel button in the lower right corner of the Generate Report window, 
to return to the CPRS. 

When working on a case that is in the Family Services Intake (FSI) or Family Services Stage 
(FSS) you can access and print reports similar to the steps for accessing and printing the CPRS 
or FRS.  
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Step by Step: 
Accessing Reports in the FSI/FSS Stage 

1 On the Assigned Workload, highlight the appropriate stage.  

2 Click on the Reports menu and select the specific report you want to view. 
The report that you wish to view displays. 

3 Click on the Print button in the lower left hand corner of the window. 
The following message displays “Print Queued”. 

4 Click the OK button. 

5 Click on the Close button. 
The Assigned Workload displays. 
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Appendix A:  
OCFS Security Guidelines
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OCFS OCFS Security GuidelinesSecurity Guidelines
Protecting Your PasswordProtecting Your Password

Make it difficult
Select a password that is easy for you to remember, but difficult for 
others to guess. Don’t be stingy—make your password as long as 
possible (at least 8 characters and up to a maximum of 13 
characters), in order to help reduce the likelihood of allowing 
someone to guess it. You cannot use all or part of your logon ID in 
your password, nor can you reuse any of your last 13 passwords.

Mix it up
Your OCFS password must contain at least one uppercase letter, one 
lowercase letter and one number. CONNECTIONS users must never 
use symbols in their passwords.

Keep it to yourself
Don’t share your password with others. Never display your password; 
if you need to write it down, don’t keep the information at your desk or 
anywhere it can be easily seen by others.

Embrace change
You must change your password periodically—at least once every 90 
days. If you think your password has been compromised, change it 
immediately. (Don’t forget to report the situation to your LAN/Security 
Administrator as soon as possible!)

Be yourself
Use only your logon ID and password; never use a current or former 
co-worker’s ID or password.

Let your fingers do the walking
Never store passwords in macros or automatic log-on features. Enter 
your password manually every time.

Your unique User ID and password not Your unique User ID and password not 
only provide you with “keys” to access only provide you with “keys” to access 

the OCFS network (including the OCFS network (including 
CONNECTIONS, as applicable),CONNECTIONS, as applicable),

they also serve as a form of they also serve as a form of 
identificationidentification——linking you to your linking you to your 

actions in the system.actions in the system.
YOU are responsible for actions taken YOU are responsible for actions taken 

with your User ID and password! with your User ID and password! 
Always follow established password Always follow established password 

protocols to help prevent unauthorized protocols to help prevent unauthorized 
use of your User ID and password.use of your User ID and password.

If you think your password has been If you think your password has been 
compromised, change it immediately compromised, change it immediately 

AND report the situation to your AND report the situation to your 
LAN/Security Administrator.LAN/Security Administrator.

Security is everyone’s Security is everyone’s 
responsibility!responsibility!

These guidelines are advisable for These guidelines are advisable for all all of your passwords.of your passwords.  
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OCFS OCFS Security GuidelinesSecurity Guidelines
Protecting Confidential InformationProtecting Confidential Information

Maintain confidentiality 24/7
Protecting confidential information encompasses all spoken, 
handwritten, printed and electronically transmitted notes and 
communications. When you make case visits, be sure to keep 
client-identifiable casework documentation with you at all times and 
never allow unauthorized individuals to view the information. 
Remember that all case and system information must be used only 
for legitimate business purposes. If you must keep hard copies of 
confidential information at your desk, always lock your desk 
whenever you are away from it. If hard copies need to be 
discarded, always run them through a cross-cut shredder.

Don’t kick this habit
It’s easy to become complacent or to think, “I’ll only be away from 
my computer for a few minutes.” If you are logged on to the 
system, always lock your computer (or log off the network) by 
holding down the Ctrl+Alt+Del keys at the same time. Do this 
every time you leave your desk; this helps prevent unauthorized 
individuals from using your User ID and password to access the 
network. 80% of security breaches are unauthorized people using an 
authorized user’s computer, NOT hacking in from outside.

Hit the road, but…
Be particularly careful when using portable electronic devices,
such as laptop computers, Quick Pads, voice recorders and PDAs. 
Don’t leave confidential information on these devices longer than is 
absolutely necessary. If the device has the ability to transmit 
information, avoid transmitting confidential information over 
wireless connections or unsecured public connections. When 
traveling with the device, keep it with you at all times; never check 
it into airline luggage systems.Security is everyone’s responsibility.Security is everyone’s responsibility.

Always follow established security protocols to help protect conAlways follow established security protocols to help protect confidential information.fidential information.

Exercise care with voicemail and e-mail
When conducting casework or other legitimate business contacts 
by phone, it’s inevitable that you may sometimes need to leave a
voicemail message or send an e-mail to a contact. Never include 
confidential information in voicemail you leave or e-mail you send.

Don’t convey confidential information where others 
can intercept it
Caseworkers have an obligation to preserve the confidentiality 
rights of the children and families with whom they work. Other staff 
may also have legitimate access to this information. If you must
discuss confidential information on the phone, avoid areas where
your conversation can be overheard. Remember that cellular 
phone lines are not sufficiently secure to be appropriate when 
discussing confidential information. Never save confidential 
information to the hard drive of any desktop computer. Check the 
permission levels on your Microsoft Outlook folders; make sure you 
understand what each level of access means and assign 
permissions on a need-to-know basis only.

The walls have ears
Be mindful of protecting confidential information in areas where
you can be easily overheard, such as in cubicle areas.

Use follow-through when faxing
If you need to transmit any confidential information via fax, call first 
before sending the fax, in order to alert the intended recipient that 
you are sending a fax. Be sure to call the recipient afterward, too, 
to verify that the fax was received and that it was not left on the fax 
machine. Avoid faxing confidential information whenever possible.
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Match Criteria Guidelines 
Use each of the Match Criteria in conjunction with each other to decide if you have a person 
match that you can relate. When in doubt, do not relate a person. If you get more information 
you can perform a person search again. (The names of grandparents or other siblings of a 
household member may help you determine if you have a match.) 

Name: First and Last Name- there may be spelling variations i.e. Crystal/ Christal/ Krystal. 
Misspellings occur due to the information provided at intake and during investigation. Watch for 
Also Known As (AKA) or other case name links as you view searches. Search AKA’s.  

Address: Address/ County. You are seeing the historical address in person search results, not 
necessarily the most recent. We are a mobile society- don’t rule out a name solely based on 
address.  

Composition: The case composition of the case you are entering verses the case you are 
finding through person search may reveal your person match. You may match AKA’s, first 
name, no last name, ages of children and a mother, etc.  

Date of Birth (DOB) or Age: Estimated dob’s are 01-01-year. DOB’s are not always accurate on 
database, neither is the age. Converted DOB’s during the 70’s are not accurate. There are 
Grand parents with 1970’s DOB’s who are actually now in their 60’s, so look at the case 
composition to determine if it is a match. On the person search results window there is a column 
labeled “T” for Type. This field displays a DOB type indicator as follows: “E” is DOB was 
estimated. “A” for approximate DOB. These are considered when scoring search results. Blank 
in the type field means that the DOB displayed is the exact DOB. These will be considered 
when scoring individuals.  

Gender or Sex: Many names are used for either gender. The gender may be entered 
incorrectly. U code gives the most complete listing of names, male and female and unknown. 
Gender will not exclude names but will be used to score the results.  

Ethnicity and Race: CONNECTIONS uses both Ethnicity and Race; originally there were few 
ethnic/race codes - black, white, Spanish, oriental, American Indian and other.  
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Progress Notes Guidelines 
Progress notes record the caseworker’s investigative, assessment and intervention activities in 
an objective and behaviorally descriptive way and should support the caseworker’s conclusions 
about safety, risk, family functioning, and the credible evidence that exists or fails to exist to 
substantiate allegations of child abuse and maltreatment. Additional casework activity which 
supports decision making and service and permanency planning is to be documented in 
progress notes for cases open for services and for cases in which children have been placed in 
out of home care. Progress notes should be recorded contemporaneously with the event, 
interview, observation or activity to preserve the integrity of the information being recorded. 

Use clear, descriptive, factual information. Impressions or opinions of workers may be included 
and labeled as such. Relevant information that supports the worker’s opinions and impressions 
should be included, wherever possible. Also describe results of the contact, as appropriate, 
including any decisions made, actions planned, next steps or planned follow-up. 

An important confidentiality impact should be noted: CPS workers are instructed to enter any 
identifying information related to contacts with the reporter/source in Investigation Stage 
Progress Notes only; using the “Other Participant” data field, with the value of 
“Reporter/Source”. Information identifying the reporter/source, including the agency, institution, 
organization, and/or program with which such person (s) is associated should not be 
documented in any other part of the Investigation Stage, including Safety Assessments, the 
Risk Assessment Profile, Investigative Actions, or Investigative Findings. 

Once the case is progressed to the Family Services Stage, the value of "Reporter/Source" in 
Progress Notes will be unavailable. Services case workers are instructed not to include 
information identifying the reporter/source anywhere in the Family Services Stage including 
Progress Notes documentation and FASPs. 

Progress notes must begin on the case initiation date or upon receipt of a report of suspected 
abuse or maltreatment for child protective service cases, and must continue until the case is 
closed to all services.  

Progress Notes, as the record of service provision, case events, activities and contacts, must 
include, but are not limited to:  

(1) descriptions of contacts with children and parent(s) receiving services, including missed or 
cancelled appointments, and the reasons therefore;  

(2) actions taken in the investigation of a reported case of child abuse or maltreatment, including 
emergency and/or controlling interventions taken, and descriptions of collateral contacts and 
other activities relating to the collecting of information needed to formulate an assessment, 
and/or assist with making a determination regarding the report of abuse or maltreatment; 
provided, however, the name or other information identifying the reporter and/or the source of a 
report of suspected child abuse or maltreatment, as well as the agency, institution, organization, 
and/or program with which such person (s) is associated, must only be recorded or documented 
in progress notes and such documentation must be recorded in the manner specified by OCFS; 

(3) efforts made to engage the family members in the development of the service plan, their 
level or degree of participation in the process and the family and children's reactions to services; 

(4) referrals and communications with other service providers involved in the case, and 
information received from specialized rehabilitative and supportive service providers concerning 
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casework contact activities with a child and/or family receiving preventive and/or protective 
services; 

(5) referrals and communications with the local probation department regarding a child in the 
case; 

(6) descriptions of contacts with educational/vocational personnel on behalf of a child; 

(7) court hearings or other legal activities; 

(8) significant events such as births, marriages, and divorces; and 

(9) documentation of caseworker / supervisor conferences, including a description of the nature 
of the discussions and any required follow-up activities. 

(10) For children in foster care or an alternative placement setting progress notes must also 
include: 

(i) casework contacts with child’s parent(s), guardian, and/or relatives, the child and the child’s 
day-to-day caretaker(s) including casework contacts required in accordance with OCFS 
regulations;  

(ii) descriptions of activities related to medical and dental examinations required on a regularly 
scheduled basis, including the initial medical examination, and any significant results, diagnosis, 
referrals and prescribed medications arising from such medical and dental examinations in 
accordance with OCFS regulations;  

(iii) descriptions of parental and/or guardian visits with a child, and any missed visits and the 
reasons therefore; 

(iv) descriptions of visits with the child, including but not limited to visits with siblings and/or half-
siblings not placed with the child, potential permanency resources and any other persons of 
significance to the child;  

(v) chronological documentation of diligent efforts, as required by OCFS regulations, by an 
authorized agency to assist, develop and encourage a meaningful relationship between the 
parent(s) and the child;  

(vi) efforts by parent(s) to provide an adequate home and provide parental care for the child, or 
when it is determined that permanency for a child cannot be achieved within the child's own 
family, discussions between the parent(s) and the authorized agency regarding the pursuit of 
adoption or another permanency planning goal for the child; and 

(vii) documentation that the parent(s) were advised of the possible consequences if a child 
remains in foster care for 15 of the most recent 22 months, and of discussions with parent(s) 
regarding the deleterious effects of foster care on the child and the child’s need for permanency.  

(11) For children in foster care with certified or approved foster parents: 

(i) documentation that foster parents have been informed of the visiting plan for the child’s 
parent(s), guardian(s), siblings or half-siblings, or others for whom a visiting plan with the child 
exists; 

(ii) documentation that the foster parents or prospective foster parents have been asked 
whether they will accept a sibling group, if appropriate; 
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(iii) documentation that the foster parents have been provided with information on the existence 
and location of all siblings or half-siblings of any child placed with them;  

(iv) documentation that foster parents have been apprised of any special needs that the foster 
child has and the available supports and services to address the special needs; and 

(v) documentation that the foster parents have been informed that diligent efforts will be made to 
facilitate regular biweekly visitation or communication between minor siblings or half-siblings 
who have been placed apart, unless such contact would be contrary to the health, safety or 
welfare of one or more of the children or unless the lack of geographic proximity precludes 
visitation. 

(12) Progress notes need not include clinical notes, daily logs or other written material created 
by service providers who act in roles other than Caseworker, CPS Worker/Monitor, Case 
Planner and Case Manager.  

Progress Notes for Consolidated Investigations must include the following documentation:  

• Prior to supervisory approval, document the following statement in the Investigation 
(INV) Conclusion for the investigation that is being “closed as duplicate”: For information 
regarding the allegation(s) contained in this associated Intake report, please see the 
Investigation Summary Report for Investigation (INV) stage ID. 

• Prior to supervisory approval, document the following statement in the Investigation 
Conclusion for the investigation that information is being consolidated into: This 
Investigation Conclusion pertains to the allegation(s) contained in the associated Intake 
reports for Investigation (INV) stage ID and Investigation (INV) stage ID. 
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